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Preface

Oracle MICROS Simphony is a cloud-based Point-of-Sale (POS) solution that provides
business management capabilities using a single tool with vast integration capabilities to
property management systems, paperless kitchen display systems, credit card interfaces, and
reporting applications.

Purpose

This guide explains how to set up delivery service providers to connect to Simphony.

Audience

This document is intended for system administrators of Oracle MICROS Simphony.

Customer Support

To contact Oracle Customer Support, access the Customer Support Portal at:

https://iccp.custhelp.com/

When contacting Customer Support, please provide the following:

• Product version and program/module name

• Functional and technical description of the problem (include business impact)

• Detailed step-by-step instructions to re-create

• Exact error message received and any associated log files

• Screen shots of each step you take

Documentation

Product documentation is available on the Oracle Help Center at https://docs.oracle.com/en/
industries/food-beverage/pos.html.

Simphony eLearning

The Simphony Learning Subscription provides additional product knowledge through
interactive training, guided video tours, and helpful knowledge checks. After exploring the
documentation library, use your Oracle Single Sign On to check out the Simphony learning
opportunities at Hospitality Learning Subscriptions.

Revision History

Date Description of Change

December 2022 Initial publication for Simphony 19.4.

January 2023 Added Rappi chapter.
Updated Configuring an Open Discount.
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Date Description of Change

February 2023 Updated the following topics:
• Deliveroo
• Sample JSON: DoorDash Single Menu in the

DoorDash chapter
• Sample JSON: Glovo in the Glovo chapter

May 2023 Added Skip chapter.
Added Postmates to the Uber Eats chapter.
Added Disabling Delivery Platforms to the
Getting Started chapter.
Updated Registering with Rappi in the Rappi
chapter.

July 2023 Updated Deliveroo.
Updated Introduction to Delivery Connectors.

October 2023 Added Deactivating Third Party Delivery
Aggregators to the Getting Started chapter.
Updated Configuration Checklist in the Getting
Started chapter.

February 2024 Updated the following topics in the Getting
Started chapter:
• Information Required for Delivery Service

Providers
• Configuration Checklist
Added Configuring Advanced Menu Item
Options section to each delivery service
provider chapter.

June 2024 Updated the following topics in the Getting
Started chapter:
• Introduction to Delivery Connectors
• Information Required for Delivery Service

Providers
• Configuration Checklist
Added Configuring Combo Meals in the
Deliveroo, DoorDash, and Uber Eats/Postmates
chapters.
Updated Configuring Workstations in every
chapter.
Added Configuring an Open Service Charge to
the Skip chapter, and updated Sample JSON:
Skip.
Removed Glovo chapter from document.
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1
Getting Started

This document contains the steps required to configure delivery service providers with
Simphony POS software.

Introduction to Delivery Connectors
Delivery connectors let you connect Simphony to delivery service providers. You can manage
your delivery platforms in Simphony by:

• Pushing updated menus (including images and prices) to the delivery service provider
system.

• Receiving orders from delivery device providers.

• Routing delivery service provider orders to kitchen devices.

The following delivery service providers are supported:

• Deliveroo

• DoorDash

• Rappi

• Skip The Dishes

• Uber Eats/Postmates

Conversational Ordering is not supported with delivery service provider integrations.

POS Version Support
Delivery service provider integration is supported with Simphony Cloud Services release 19.2.1
and later for the following editions:

• Essentials Edition

• Plus Edition

• Enterprise Edition

• Single-Tenant Edition

Delivery Connectors are part of the Simphony Transaction Services Cloud Service, which is a
subproduct of Simphony Cloud Services and requires a subscription. See the Oracle MICROS
Simphony Licensing Information User Manual for more information.

Abbreviations and Acronyms
The following abbreviations and acronyms are used throughout this document.
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Table 1-1    Abbreviations and Acronyms

Abbreviation or Acronym Definition

API Application Programming Interface

EMC Enterprise Management Console

POS Point-of-Sale

SLU Screen Lookup

STS Gen2 Simphony Transaction Services Generation 2

Information Required for Delivery Service Providers
The following Simphony information is pushed to the delivery service providers.

Table 1-2    Information Required for Delivery Service Providers

Simphony
Item to
Configure

Deliveroo DoorDash Rappi Skip Uber Eats/
Postmates

Tender/Media Required Required Required Required Required

Order Type for
Delivery

Required Required Required Required Required

Order Type for
Remakes

Required Not Supported Not Supported Required Not Supported

Open Discount Required Not Supported Required Required Not Supported

Open Service
Charge

Not Supported Not Supported Not Supported Required Not Supported

Delivery
Service
Provider
Employee

Required Required Required Required Required

Data Extension
Record

Required Required Required Required Required

Currency Required Required Required Required Required

Language
Culture

Required Required Required Required Required

Menu Tags Required Required Required Required Required

Customer
Facing Menu
Item Name

Required Required Required Required Required

Customer
Facing Menu
Item
Description

Required Required Required Required Required

Menu Item
Image

Required Required Required Required Required

Menu Item
Price

Required Required Required Required Required

Chapter 1
Information Required for Delivery Service Providers
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Table 1-2    (Cont.) Information Required for Delivery Service Providers

Simphony
Item to
Configure

Deliveroo DoorDash Rappi Skip Uber Eats/
Postmates

Screen Look
Up (SLU)

Required Required Required Required Required

Condiments Required Required Required Required Required

Nutrient Set Not Supported Not Supported Not Supported Not Supported Optional

Allergen Optional Optional Optional Optional Not Supported

Combo Meals Optional Optional Not Supported Not Supported Optional

Price Sequence
Level Filter

Optional Optional Optional Optional Optional

Condiment
Group Filter

Optional Optional Optional Optional Optional

Image Slot Optional Optional Optional Optional Optional

SLU Slot Optional Optional Optional Optional Optional

Default
Condiments

Not Supported Optional Not Supported Not Supported Optional

KDS
Notification

Not Supported Optional Not Supported Not Supported Optional

Click a delivery service provider for information on how to configure Simphony for the selected
provider:

• Deliveroo

• DoorDash

• Rappi

• Skip

• Uber Eats/Postmates

Configuration Checklist
EMC setup activities related to delivery service providers can start without the connection
details. However, you cannot use the delivery service provider without them. To obtain
connection details, complete this checklist for integrating Simphony with a delivery service
provider:

1. Register with Delivery Service Provider

2. Enable Locations Using Delivery Connector User Interface (if required and supported by
Delivery Service Provider)

3. Enable STS Gen 2 For Use With Delivery Service Provider Workstation

4. Configure Tender/Media

5. Configure Order Types

6. Configure an Open Discount (if required and supported by Delivery Service Provider)

7. Configure an Open Service Charge (if required and supported by Delivery Service
Provider)

Chapter 1
Configuration Checklist
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8. Create Delivery Service Provider Employee

9. Create Data Extension Record

10. Configure Currency Information

11. Configure Language Culture

12. Create Allergen Classes (if required and supported by Delivery Service Provider)

13. Upload Menu Item Image

14. Create Menu Tags

15. Create Screen Look Ups for Menu Items

16. Configure Menu Items (including condiments)

17. Configure Nutrient Set (if required and supported by Delivery Service Provider)

18. Assign Allergy Information for a Menu Item (if required and supported by Delivery Service
Provider)

19. Configure Combo Meals (if required and supported by Delivery Service Provider)

20. Assign a SLU and arrange the order of SLUs for the ordering site

21. Configure Advanced Menu Item Options (if supported by Delivery Service Provider)

22. Create Delivery Configuration in Revenue Center

23. Deactivate Third Party Delivery Aggregator Services (if used)

24. Activate Delivery Service Provider Interface

25. Verify Setup

Deactivating Third Party Delivery Aggregators
If you use a third party delivery aggregator or order integrator (for example, Deliverect or
Otter), you need to deactivate these services; otherwise Delivery Connectors will not be able to
connect properly with Simphony.

Disabling Delivery Platforms
If you no longer use a delivery service provider, you need to disable the interface for the
platform that is not in use. See Activating the Delivery Service Provider Interface to disable the
platform.

Chapter 1
Deactivating Third Party Delivery Aggregators
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2
Deliveroo

Deliveroo is supported with Simphony release 19.2.1 and later. Review the following checklist
before you set up Simphony for Deliveroo:

• Decide on your menu. Deliveroo supports one menu.

• Decide on a unique tag name for the menu.

• Plan the list of menu items.

• Determine menu availability. For example, will the menu be available only on weekdays
between specific times?

• The menu can have multiple categories but must have at least one category. A category is
a group of similar menu items. For example, you can have a lunch menu with categories
for salads, sandwiches, and desserts.

In Simphony, a category corresponds to a SLU. Each category needs its own SLU.

Note:

Deliveroo supports a maximum of 100 SLUs.

• Decide on an image to display for the menu. This is required. You can upload the menu
image to the Oracle Object Store through a dummy menu item.

• Consider the following characteristics of each menu item:

– Customer-facing menu item name

Note:

Deliveroo menu sync does not accept menu item names which contain fewer
than two characters. This can cause issues when using the Chinese
language.

– Customer-facing menu item description

– Menu item image that meets the following specifications:

* JPEG or PNG file format

* Pixel size of 1920 x 1080

* Aspect ratio of 16:9

– Menu item price

– Allergen classes

• Consider the display of menu items on delivery platform ordering sites and kiosks, and
determine whether advanced menu options are needed:

– Price sequence level filter

2-1



– Condiment group filter

– Image slot

– SLU slot

Registering with Deliveroo
1. Sign up for Deliveroo.

2. Establish a store in Deliveroo for each revenue center that will process Deliveroo orders.

3. Complete the Tech Partner POS & Menu API form, located at https://
app.smartsheet.com/b/form/8aa12503c01443f48a5e1b5969104bbd.

4. Receive an email from Deliveroo confirming successful processing of your integration
request, and advising of the Brand ID and each store’s Site ID.

Transaction Services Generation 2
The delivery service provider integration requires Simphony Transaction Services Generation 2
(STS Gen2).

For locations that will integrate with delivery service providers, follow these steps to either
enable STS Gen2 for the first time, or confirm that it is set up correctly.

Configuring Workstations
Add a SimphonyTransaction Services Generation 2 (STS Gen2) workstation or validate that an
existing STS Gen2 workstation is configured for each location. The STS Gen2 workstation
must be a CAPS Service Host and the Type must be POS API Client.

If you have more than one POS API Client workstation type available in a revenue center,
Oracle Food and Beverage recommends enabling at least two workstation devices that can
receive checks and orders as this will provide resiliency should one of the workstations
become unavailable.

1. Log in to EMC.

2. Select the location (property), click Setup, and then click Workstations.

3. If you do not see an STS Gen2 workstation in the list that is a CAPS Service Host with
Type POS API Client, follow these steps:

a. Locate the workstation record with the Check and Posting Service (CAPS), and then
double-click the column number to the left of this workstation record to open it.

The CAPS workstation record is usually the first one listed.

b. Click the Service Host tab, and confirm that the Type value shows Check and
Posting (CAPS).

c. Select the CAPS workstation in the list in the left pane, and then click the General tab.

d. Click the insert icon
(

) on the toolbar.

e. Enter STSCAPS in the Record Name field, and then click OK.

Chapter 2
Registering with Deliveroo
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f. Click the General tab, and then select 3 - POS API Client from the Type drop-down
list.

g. In the General Settings section, select Enable Simphony Transaction Services (Gen
2) Cloud API.

h. Confirm that the Type value shows 3 - POS API Client.

i. In the Service Host ID field, select the Service Host that is running CAPS.

j. Click the Order Devices tab, and then enable the order devices on which online
orders will print.

k. Click the Transactions tab, and then select the Default Order Type for the
workstation.

l. Click the Revenue Centers tab, and then select the revenue center from the drop-
down list.

m. Click Save.

Configuring Revenue Center Parameters
1. Log in to EMC.

2. Select the revenue center, click Setup, and then click RVC Parameters.

3. Click the Options tab, and then enable 74 - Enable Simphony Transaction Services
Gen 2.

Figure 2-1    RVC Parameters Options

4. Click Save.

Creating Tender Media
You need to create a dedicated tender record for each delivery service provider. These tender
records are used when posting delivery service provider orders. The tenders can be set up to
process online orders.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a tender record for each food delivery order, enter the name (for example,
UberEatsAccount, PostmatesAccount, DeliverooAccount, DoorDashAccount,
GlovoAccount, RappiAccount, and so on), and then click OK.

Chapter 2
Creating Tender Media
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3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click the Options tab, and then click the Ops Behavior subtab.

6. Select 3 - Assume Paid in Full.

7. Click Save.

Creating Order Types
Create an order type for each delivery service provider you do business with. See the Oracle
MICROS Simphony Configuration Guide for more information on configuring order types.
When creating the order type, keep these points in mind:

• Name the order type after the delivery service provider.

• Tax is not billed to delivery service provider orders. The delivery service provider collects
taxes from the customer. In the Order Type Parameters module, do not select any tax rates
in the Tax Masks column.

• Use a separate order type for remake orders.

While it is possible to use existing order types with each delivery service provider, configuring
an order type specifically for each delivery service provider makes it easier to track the orders
for that delivery service provider in the kitchen and on reports.

Configuring an Open Discount
Configure an open dollar discount for Deliveroo, which is used for promotions. See
Configuring Discounts in the Oracle MICROS Simphony Configuration Guide for detailed
instructions. When configuring discounts in the EMC Discounts module, General tab, name the
discount after the delivery service provider (for example, DeliverooDiscount), set the
Condiment Discountability to 4 - Parent and All Condiment Items, and enable the discount
option 1 - ON = Open; OFF = Preset.

Creating a Deliveroo Employee
Deliveroo orders enter Simphony using an employee configured for this purpose. Configuring a
dedicated employee record for Deliveroo orders allows you to track these orders.

See the Oracle MICROS Simphony Configuration Guide for more information on configuring
the transaction services default employee and how to create the employee record.

After adding the employee, record the value shown in the # field of the Employee Maintenance
module. The delivery configuration in the revenue center requires the POS employee object
number (shown in the # field) when configuring the JSON file in a later section of Deliveroo
configuration.

Adding a Data Extension Record
1. Select the Enterprise, click Configuration, and then click Data Extensions.

Chapter 2
Creating Order Types
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Figure 2-2    EMC Enterprise Main Menu

2. Click the Insert  icon on the toolbar to add a record, enter the Data Extension record
name, and then click OK.

Figure 2-3    EMC Enterprise Main Menu

3. Enter information in the following fields:

Table 2-1    Data Extension Fields

Field Description

Table Select 20 - Revenue Center.

Extra Column Name Enter DeliveryPlatformConfigurationData.

Type Select 12 - Json.

Chapter 2
Adding a Data Extension Record
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Table 2-1    (Cont.) Data Extension Fields

Field Description

Data Constraints Select Max Chars: 9999.

Sort Priority Not applicable; use default value.

Display Width Enter 150.

Translatable Name Not applicable; use default value.

Translatable Help Not applicable; use default value.

Figure 2-4    Data Extension Module Fields

4. Click Save.

Configuring Currency Settings
1. Select the Enterprise, property, or zone, click Setup, and then click Currency.

2. Double-click the record for the currency used by the delivery service provider (for example,
US Dollars).

3. Enter or change the Abbreviation for the currency per the ISO 4217 currency code
standards.

See the Oracle MICROS Simphony Configuration Guide for more information on
configuring currencies.

4. Click Save.

Configuring the Language Culture
1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the language record, and then click the Miscellaneous tab.

3. Select the Locale ID, and then enter the Language Culture corresponding to the
language.

Chapter 2
Configuring Currency Settings
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Ensure that the Language Culture is set to the appropriate value for the language. See
the Oracle MICROS Simphony Configuration Guide for more information on configuring
languages.

4. Click Save.

Creating Allergen Classes
1. Select the Enterprise level, click Descriptors, and then click Allergen Names.

Figure 2-5    EMC Enterprise Descriptors Tab - Allergen Names

• The module has several pre-configured allergen names/codes.

Chapter 2
Creating Allergen Classes
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Figure 2-6    EMC Allergen Names Module

• The existing allergen names and codes cannot be edited or deleted; however the text
can be translated.

2. To insert new allergen names:

Chapter 2
Creating Allergen Classes
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a. Click the insert icon

on the toolbar.

b. After adding a record, click OK, and then click Save.

The system does not allow duplicate allergen names.

Figure 2-7    Inserting Allergen Names

3. Select the Enterprise level, click Configuration, and then click Allergen Classes.

Chapter 2
Creating Allergen Classes
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Figure 2-8    EMC Configuration Tab - Allergen Classes

4. Insert a new record and enter a name for the allergen class.

You can configure the Allergen Classes module from either table or form view. In table
view, if more than one allergen is selected, allergens are listed and comma separated.

Figure 2-9    Allergen Classes - Table View

5. Based on the allergy class’ name, select the allergen you want to include in the class.

You can select more than one allergen. Switch to form view by using the toggle icon on the
toolbar

, or double-click the record.

This is an example of an allergen class named Seafood. Each allergen selected here is
seafood related.

Chapter 2
Creating Allergen Classes
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Figure 2-10    Allergen Classes - Form View

6. Create as many allergen classes as needed, and then click Save.

7. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

8. On the General tab, assign an allergen class from the drop-down list in the Allergen
Class field, and then click Save.

Chapter 2
Creating Allergen Classes
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Figure 2-11    Menu Item Classes - Allergen Class Field

9. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

10. Search Menu Item Definition records for items you wish to assign an allergen class.

11. On the record’s General tab, select the allergen class from the drop-down list that you
want to assign to the menu item class from the Allergen Class Override field, click OK,
and then click Save.

Chapter 2
Creating Allergen Classes
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Figure 2-12    Menu Item Definition - Allergen Class Override Field

Creating Menu Tags
A delivery service provider menu is a collection of Simphony menu items. Use a menu tag to
associate a Simphony menu item with the delivery provider menu. Each provider must have a
unique menu tag in Simphony. Only the menu items with these tags are visible in the delivery
provider application.

You need to have the role privilege to view, edit, add, or delete tags. See the Oracle MICROS
Simphony Configuration Guide for more information on creating roles and setting privileges for
tags in the Roles module, EMC Modules tab.

Simphony retains all tag activity (including add, edit, and delete) for use in auditing.

1. To create a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Click the insert icon
(

) on the toolbar.

c. Add a new tag record with the appropriate name (for example, Online Only), and then
click OK.

You cannot duplicate tag names.

d. Click Save.

2. To edit a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Change the tag name in the Name column.
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c. Click Save.

3. To delete a tag:

If you delete a tag that is associated with a menu item definition, the association is also
deleted.

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Highlight the tag record, click the delete icon
(

) on the toolbar, and then click Yes.

c. Click Save.

4. To associate a tag with a menu item definition, see the Oracle MICROS Simphony
Configuration Guide for instructions.

Creating Screen Look Ups for Menu Items
You can assign each menu item definition to a maximum of eight different SLUs in table view of
the Menu Item Maintenance module. Assigning multiple SLUs to a menu item allows flexibility
in building POS client pages that are customized to use dine in, carry out, and curbside to go,
and shows the menu items supported by the order type.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click
Menu Item.

2. Insert a new record, enter a name for the menu item screen look up (for example,
DinnerCarryOut) in the Record Name field, and then click OK.

3. Repeat step 2 to add more SLUs, and then click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

5. To assign a SLU, click the ellipsis point (...) button adjacent to the menu item First Name,
select the SLU, and then click OK.

To assign another SLU to the menu item, select the SLU from the SLU 2 column. You can
assign up to eight SLUs per menu item. Duplicate SLUs do not appear on the same
workstation page.

6. (Optional) To assign a SLU sort priority:

a. Double-click a menu item, and then click General.

b. Select the relevant SLU from the Touchscreen Properties section.

Use the SLU 2, SLU 3, and so on for multiple SLUs.

c. Enter a SLU Sort Priority (between 1-99) for the menu item.

Use this field when Page Design Layout option, Use Sort Priority, is enabled from the
Screen Lookup settings.

When SLU Sort Priority is used, menu items with Sort Priority 1 appear on the screen
first, followed by menu items with Sort priority 2, and so on up to Sort Priority 99, and
then finally Sort Priority 0 items. (Priority 0 means “Do not sort”; items with 0 appear at
the end of the list.) Typically the most popular menu items have Sort Priority 1 for easy
access. Items in the same SLU can belong to the same Sort Priority.
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Figure 2-13    Page Design Screen Lookup (SLU) Layout Settings

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Menu Item from the Type drop-down list, select SLU as the Property, and then
select the menu item screen lookup as the Value.

11. Select the Menu Item Display Name, and then click Save.

12. If the revenue center uses hand held POS client devices:

a. Select Dynamic SLU as the Property, and then select a menu item screen look up
group as the SLU Value.

b. Enter a non-zero value for the Visual State(s).

The application uses the Visual State value to link menu item screen look ups with
their corresponding Visual State buttons, which workstation operators use to change
the menu items that appear in the Dynamic SLU.
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c. To add more screen look ups to the Dynamic SLU, click Add.

d. Select the Menu Item Display Name, and then click Save.

e. Insert buttons for each screen look up that you added to the Dynamic SLU.

For example, if you added five screen look up groups to the Dynamic SLU, insert five
buttons.

f. Select Function from the Type drop-down list, and then select Visual State from the
Function list.

g. In the Arguments field, enter the Visual State value that you assigned to a screen
look up group in Step 12-b.

h. Click Save.

Configuring Menu Items
Delivery service provider integrations do not support combo meals or conversational ordering.

After creating menu items, add condiments to the items that need them, and then follow these
steps:

1. If necessary, update the menu tag as described in Creating Menu Tags.

2. Update and assign the SLU to the menu item as described in Assigning a SLU.

3. If necessary, update the menu item prices as described in Setting Menu Item Prices.

4. Specify the menu item name, item description, and image the customer sees when
ordering through the delivery application. See Configuring Customer-Facing Content for
more information.

5. If necessary, update the allergen class as described in Assigning Allergy Information for a
Menu Item.

6. Change the availability status of a menu item to generate a notification through the delivery
application, advising Deliveroo of the menu item’s new status (unavailable or available).
These updates are immediately sent to Deliveroo and will update in near real time.

Assigning a SLU

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then double-click the menu item in the list.

3. Click the General subtab.

4. In the Touchscreen Properties section, select the relevant SLU from the drop-down lists in
SLU through SLU 8.

You can assign up to eight SLUs per menu item. The SLU number specifies the order in
which SLUs appear on the delivery provider ordering site (from least to greatest number).
For example, a menu item assigned to SLU 2 will appear in the Entrees category:

1 Starters

2 Entrees

3 Desserts

5. Click Save.
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Setting Menu Item Prices

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Prices subtab.

4. Set the menu item price in the Price column.

If the menu item has multiple prices associated with different menu levels, ensure that
each level has an appropriate prefix configured. See the Oracle MICROS Simphony
Configuration Guide for information on setting main, sub, and custom menu levels.

5. Click Save.

Configuring Customer-Facing Content
Specify the menu item name, description, and image that customers see in the delivery
provider application when placing an order.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Images subtab.

4. Enter or change the Consumer Item Name.

5. Enter or change the Consumer Item Description.

6. In the Image 1 section, click Upload to select the image and upload it to Simphony.

7. (Optional) Enter or change the image Title.

8. (Optional) Enter or change the image Comments.

9. Enter the URL that links to the image.

The image URL is required for integration functionality.

10. Click Save.

Assigning Allergy Information for a Menu Item
When using Deliveroo, you have the option to include allergen information for a menu item on
the delivery service provider application.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the General subtab.

4. In the Allergen Class Override field, click Select, select the allergen class, and then click
OK.

5. Click Save.
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Configuring Combo Meals
Simple combo meals are supported with Deliveroo; sized combo meals are not supported with
delivery service providers. Complete the Simphony combo meal configuration described in 
Combo and Fixed Price Meals in the Oracle MICROS Simphony Configuration Guide, but do
not configure sized combo meals.

The following configuration is required to synchronize combo meals from Simphony to delivery
providers through delivery connectors:

1. Create Combo Meal Groups.

If condiment items (not parents) are included as part of a combo group, these items are
ignored during the menu synchronization.

See Creating Combo Meal Groups in the Oracle MICROS Simphony Configuration Guide
for more information.

2. Tag the corresponding Menu Item Master.

To include a combo in the synchronization process, the corresponding Menu Item Master
must be tagged. Items within a combo group do not need individual tags. However, if items
within a combo group are tagged individually, they appear on the delivery service provider
UI as both part of the combo and as individual à la carte items.

See Configuring Menu Tag Groups and Tags in the Oracle MICROS Simphony
Configuration Guide for more information.

Review and understand the following considerations before attempting to synchronize combos
with the delivery service provider. Ensure that your combo meal configurations adhere to these
guidelines to ensure a smooth and accurate synchronization process.

Table 2-2    Combo Meal Setup Guidelines

Simphony Considerations Description for use with Delivery Connectors

3 - Is Sized Combo Meal option If selected, and the combo meal contains
configuration consistent with sized combos, it is
ignored by the synchronization.
If a combo meal is configured as sized but does
not contain items with size specifications, it is
treated as unsized and included in the
synchronization.
See Creating Combo Meals.

Combo Group Items with Sizes in Unsized
Combos

If a combo group item has a size specification
within an unsized combo meal, it appears on
the delivery service provider UI but is treated
as unsized.
See Creating Combo Meal Groups.
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Table 2-2    (Cont.) Combo Meal Setup Guidelines

Simphony Considerations Description for use with Delivery Connectors

Prices You can set prices for combo meals at the Menu
Item Master level, by combo group, or by
combo group item. It is recommended to set
base prices for combo meals at the Menu Item
Master level. Prices set directly on the combo
item definition are ignored. Ensure that prices
are defined for all items within a combo group
to avoid default prices of $0.00.
If the Price is not specified, Active On Level 1
is used by default.
See Combo Meal Group Pricing and Creating
Combo Meal Groups.

Alternate Groups Combo group items cannot be members of
Alternate Groups; Alternate Groups are not
supported with delivery service provider
combos.
See Creating Combo Meal Groups.

Side Count and Quantity The side count for combo groups can be
configured and is controlled in the side count
area of the Combo Group. The default count is
1.

The quantity of items within a combo group,
including modifiers or weighed items, is
controlled in the Combo Group Item area.
Deliveroo only supports a quantity of 1.

If the delivery service provider detects a combo
group item with a quantity greater than 1 for
Deliveroo, the combo is ignored, and an error is
logged. Deliveroo has a limitation where the
quantity selector is limited to 1 when a menu
item in a combo group has modifiers.
See Creating Combo Meal Groups.

Combo Meal Groups Based on Menu Item
Definition

Only Menu Item Definition 1 is supported for
combos.

Invalid Items in Combo Groups If a combo meal group does not contain valid
items, it is unable to be ordered. Invalid items
include condiments and items without
definitions.

Condiment Parent as Menu Item Master If a condiment parent is configured as a Menu
Item Master, its condiment groups are ignored,
and it is treated as a regular menu item.

Duplicate Combo Meal Groups If a combo meal group is referenced multiple
times in a combo meal, the duplicates are
ignored, and only one instance of the group is
considered.
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Configuring Advanced Menu Item Options
When considering the display of menu items on delivery platform ordering sites and kiosks,
additional menu item options are available. The modifiers and prices used in Simphony POS
Operations may not be the same as those displayed to delivery platform customers on online
ordering sites or kiosks.

You can create additional menu item definitions (see Configuring Menu Item Definitions in the
Oracle MICROS Simphony Configuration Guide), or set Delivery Connector advanced menu
item configurations options. These advanced options are controlled in revenue centers and in
JSON code, and are as follows for Deliveroo:

Price Sequence Level Filter
The price sequence filter lets you specify the menu item price sequence levels used in the
delivery service provider. You can apply the price sequence filter to base menu items (for
example, a hamburger) and to condiments (for example, cheese). This filter affects all menu
items that are passed to the delivery service provider.

See Sample JSON: Deliveroo for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

Condiment Group Filter
The condiment group filter lets you specify the condiment groups for each delivery service
provider. The filter allows the condiment groups in the Menu Item Classes module to be
included or excluded. This prevents unwanted condiments and condiment groups from being
displayed on the delivery service provider ordering site.

To specify the condiment group filter in the JSON code, set condiment group numbers
separated by commas, and true or false to indicate whether the condiment group specified
will be included or excluded from the delivery service provider.

See Sample JSON: Deliveroo for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

Image Slot
If multiple image slots are in use for an organization, the item image slot lets you specify which
menu item image slot is used for the product display in the delivery service provider, rather
than the default setting of 1. This feature is used with kiosks and online ordering sites.

See Sample JSON: Deliveroo for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

SLU Slot
The Screen Look Up (SLU) slot lets you specify which SLU slot is used for the product display
in delivery service providers. By default, the system shows all SLUs assigned to a menu item
as categories in the delivery service provider. If multiple SLUs are in use for an organization,
the SLU slots appear as multiple categories with the source product displayed in each SLU.
The selection allows customers to specify the SLU name to use as a category name in their
delivery service provider.
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See Sample JSON: Deliveroo for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

Creating Delivery Configuration in the Revenue Center
Configuration for delivery service provider platform integrations is specified in EMC through the
Data Extensions column named DeliveryPlatformConfigurationData, which is added to the
revenue center table, populated with the JSON representation of the data structure.

1. Select the property, click Setup, and then click RVC Configuration.

2. Double-click the revenue center, and then click the Data Extensions tab.

3. In the Column field, locate DeliveryPlatformConfigurationData, and then click Edit
Json.

4. Enter JSON configuration data and then click OK.

See Sample JSON: Deliveroo for a description of JSON data values and a code sample
that you can copy and change for your restaurant. After you change the sample values,
you can copy your restaurant code into the DeliveryPlatformConfigurationData column
to complete this step.

5. Click Save.

Sample JSON: Deliveroo

The following sample shows JSON code for Deliveroo. The tables that follow the code sample
describe the values in the code.

Tip:

Click Copy to copy the code to your clipboard and then paste it into a text editor such
as Notepad++. Change the values for your restaurant and then copy your code into
the DeliveryPlatformConfigurationData column as described in Creating Delivery
Configuration in the Revenue Center.

{
    "deliveryPlatformConfigurations": [
         {
            "name": "Deliveroo",
            "groupIdentifier": "my-brand-gb",
            "rvcIdentifier": "my-brand-gb-531168",
            "empNum": 991,
            "otNum": 5,
            "remakeOtNum": 6,
            "tendNum": 13,
            "priceSequences": 
                [
                {               
                "type": "BaseItem",               
                "levels": [2]           
                },           
                {               
                "type": "Condiment",               
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                "levels": [6, 7, 8]           
                }       
                ]
            "condimentGroupRuleFilter": 
                {           
                "values": "1,2,3,4",           
                "include": true   
                }
            "itemImageSlot": 2
            "sluSlot": 1
            "discountId": 2,
            "menus": [{
                    "name": {
                        "en-US": "All Day"
                    },
                    "identifier": "DeliverooAllDay",
                    "imageURL": "https://oracleobjectstore.com/images/
deliveroo-all-day-menu.jpg",
                    "availability": null
                }
            ]
        } // End of Deliveroo
    ]
}

Table 2-3    Data Extensions Column Name

Name Type Description

deliveryPlatformConfiguration
s

DeliveryPlatformConfiguratio
n[]

Revenue center’s integration
configuration for each
applicable delivery platform.

Table 2-4    Delivery Platform Configuration

Name Type Description

name string Deliveroo
Do not change this value.

groupIdentifier string Name of the grouping of
restaurants by brand name
and country. This value
consists of the brand name and
the country code.

rvcIdentifier string Identifier for the revenue
center. This is the Site ID
obtained during the
registration process.

empNum number Object number for employee to
be used to enter orders
received from the delivery
platform.

otNum number Object number for Order Type
to be used for orders received
from the delivery platform.
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Table 2-4    (Cont.) Delivery Platform Configuration

Name Type Description

remakeOtNum number Object number for Order Type
to be used for "remake" orders
received from the delivery
platform.

tendNum number Object number for Tender
Media to be used to settle
orders received from the
delivery platform.

priceSequences string
number

Type of base menu item and
condiment (optional).
Number is the price level.

condimentGroupRuleFilter number
true/false

Numbers separated by
commas. Numbers are the
condiment groups.
True directs the application to
use the numbers listed. False
excludes the numbers listed.

itemImageSlot number Menu item image slot number
used for the product display in
the delivery platform.

sluSlot number Menu item SLU slot number
used for the product display in
the delivery platform.

discountId number Object number for Discount to
be used for open discount
promotion orders received
from the delivery platform.
The discountId is required.

menus DeliveryPlatformMenu[] Details for menu(s) to be
submitted to the delivery
platform.
Make sure to follow any
limitations imposed by the
delivery platform on the
number of menus.

Table 2-5    Delivery Platform Menu

Name Type Description

name TranslatedString Display name for menu by
locale.

identifier string Identifier for menu to be used
in tags.
Make sure the identifier does
not conflict with tags used for
other purposes.
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Table 2-5    (Cont.) Delivery Platform Menu

Name Type Description

imageURL string URL for image associated with
menu.
Upload the menu image to the
Oracle Object Store through a
dummy menu item.

availability ServicePeriod[] Start and end times for each
day of the week that the menu
is to be made available.

Table 2-6    Translated String

Name Type Description

<locale code> string String translation for given
locale.

… … …

Table 2-7    Service Period

Name Type Description

dayOfWeek string First three letters of day of
week for service period.

startTime string Start time for service period, in
24-hour (hh:mm) format.

endTime string End time for service period, in
24-hour (hh:mm) format.
End time must be later than
start time.

Activating the Delivery Service Provider Interface

WARNING:

Ensure that all configuration has been completed before activating the delivery
platform.

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Interfaces tab, and then select Delivery Platform Integrations.

3. In the Delivery Platform Integrations section, select the delivery platform to enable it.

If you no longer use a delivery platform, disable it.

4. Click Save.

One hour after activation of the Delivery Platform Integrations option, the store will be
visible and ready for ordering on the delivery service provider website.
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Verifying Setup
After configuring Simphony, wait an hour and then go to the delivery service website. Verify the
following information:

1. The latest menu is synced to the website.

2. Once the menu is synced to the website, reply to the Deliveroo email and confirm that the
store can go live.

3. Once the store is live, place an order, and then confirm that the check is printed in the
kitchen.
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3
DoorDash

DoorDash is supported with Simphony release 19.4 and later. Review the following checklist
before you set up Simphony for DoorDash:

• Decide on your menu(s). DoorDash supports one or multiple menus.

• Decide on unique tag names for the menu or menus.

• Plan the list of menu items.

• Determine menu availability. For example, will the menu be available only on weekdays
between specific times?

• The menus can have multiple categories but must have at least one category. A category
is a group of similar menu items. For example, you can have a lunch menu with categories
for salads, sandwiches, and desserts.

In Simphony, a category corresponds to a SLU. Each category needs its own SLU.

Note:

DoorDash supports a maximum of 100 SLUs.

• Decide on an image to display for each menu. This is optional.

• Consider the following characteristics of each menu item:

– Customer-facing menu item name

– Customer-facing menu item description

– Menu item image that meets the following specifications:

* JPEG or PNG file format

* Pixel size of 1920 x 1080

* Aspect ratio of 16:9

Note:

All images are manually verified by DoorDash and will not appear
immediately on the ordering site.

– Menu item price

– Allergen classes

• Consider the display of menu items on delivery platform ordering sites and kiosks, and
determine whether advanced menu options are needed:

– Price sequence level filter

– Condiment group filter

– Image slot
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– SLU slot

– Default condiments

– KDS notification

Registering with DoorDash
If you are unable to locate your Simphony Home URL (OpenID Provder URL), it’s located in
the EMC Enterprise Parameters module, Applications subtab.

Note:

When copying this URL for access to Simphony Home, exclude the /oidc-provider/
portion of the URL.

1. Complete the Get Started DoorDash form, located at https://get.doordash.com/en-us, and
sign up for a merchant account.

2. Establish a store in DoorDash for each revenue center that will process DoorDash orders.

3. Advise DoorDash that this is an Oracle integration.

4. You will receive store IDs for each store created.

5. Complete the Simphony configuration steps detailed below.

6. You will receive a menu preview link following your first successful menu sync (as shown in
the Verifying Setup section).

7. Advise DoorDash that the site is ready for use, and they will perform final activation.

8. You will receive a confirmation email that your site is ready for use.

Transaction Services Generation 2
The delivery service provider integration requires Simphony Transaction Services Generation 2
(STS Gen2).

For locations that will integrate with delivery service providers, follow these steps to either
enable STS Gen2 for the first time, or confirm that it is set up correctly.

Configuring Workstations
Add a SimphonyTransaction Services Generation 2 (STS Gen2) workstation or validate that an
existing STS Gen2 workstation is configured for each location. The STS Gen2 workstation
must be a CAPS Service Host and the Type must be POS API Client.

If you have more than one POS API Client workstation type available in a revenue center,
Oracle Food and Beverage recommends enabling at least two workstation devices that can
receive checks and orders as this will provide resiliency should one of the workstations
become unavailable.

1. Log in to EMC.

2. Select the location (property), click Setup, and then click Workstations.

3. If you do not see an STS Gen2 workstation in the list that is a CAPS Service Host with
Type POS API Client, follow these steps:
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a. Locate the workstation record with the Check and Posting Service (CAPS), and then
double-click the column number to the left of this workstation record to open it.

The CAPS workstation record is usually the first one listed.

b. Click the Service Host tab, and confirm that the Type value shows Check and
Posting (CAPS).

c. Select the CAPS workstation in the list in the left pane, and then click the General tab.

d. Click the insert icon
(

) on the toolbar.

e. Enter STSCAPS in the Record Name field, and then click OK.

f. Click the General tab, and then select 3 - POS API Client from the Type drop-down
list.

g. In the General Settings section, select Enable Simphony Transaction Services (Gen
2) Cloud API.

h. Confirm that the Type value shows 3 - POS API Client.

i. In the Service Host ID field, select the Service Host that is running CAPS.

j. Click the Order Devices tab, and then enable the order devices on which online
orders will print.

k. Click the Transactions tab, and then select the Default Order Type for the
workstation.

l. Click the Revenue Centers tab, and then select the revenue center from the drop-
down list.

m. Click Save.

Configuring Revenue Center Parameters
1. Log in to EMC.

2. Select the revenue center, click Setup, and then click RVC Parameters.

3. Click the Options tab, and then enable 74 - Enable Simphony Transaction Services
Gen 2.
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Figure 3-1    RVC Parameters Options

4. Click Save.

Creating Tender Media
You need to create a dedicated tender record for each delivery service provider. These tender
records are used when posting delivery service provider orders. The tenders can be set up to
process online orders.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a tender record for each food delivery order, enter the name (for example,
UberEatsAccount, PostmatesAccount, DeliverooAccount, DoorDashAccount,
GlovoAccount, RappiAccount, and so on), and then click OK.

3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click the Options tab, and then click the Ops Behavior subtab.

6. Select 3 - Assume Paid in Full.

7. Click Save.

Creating Order Types
Create an order type for each delivery service provider you do business with. See the Oracle
MICROS Simphony Configuration Guide for more information on configuring order types.
When creating the order type, keep these points in mind:

• Name the order type after the delivery service provider.

• Tax is not billed to delivery service provider orders. The delivery service provider collects
taxes from the customer. In the Order Type Parameters module, do not select any tax rates
in the Tax Masks column.

• Use a separate order type for remake orders.

While it is possible to use existing order types with each delivery service provider, configuring
an order type specifically for each delivery service provider makes it easier to track the orders
for that delivery service provider in the kitchen and on reports.
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Creating a DoorDash Employee
DoorDash orders enter Simphony using an employee configured for this purpose. Configuring
a dedicated employee record for DoorDash orders allows you to track these orders.

See the Oracle MICROS Simphony Configuration Guide for more information on configuring
the transaction services default employee and how to create the employee record.

After adding the employee, record the value shown in the # field of the Employee Maintenance
module. The delivery configuration in the revenue center requires the POS employee object
number (shown in the # field) when configuring the JSON file in a later section of DoorDash
configuration.

Adding a Data Extension Record
1. Select the Enterprise, click Configuration, and then click Data Extensions.

Figure 3-2    EMC Enterprise Main Menu

2. Click the Insert  icon on the toolbar to add a record, enter the Data Extension record
name, and then click OK.
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Figure 3-3    EMC Enterprise Main Menu

3. Enter information in the following fields:

Table 3-1    Data Extension Fields

Field Description

Table Select 20 - Revenue Center.

Extra Column Name Enter DeliveryPlatformConfigurationData.

Type Select 12 - Json.

Data Constraints Select Max Chars: 9999.

Sort Priority Not applicable; use default value.

Display Width Enter 150.

Translatable Name Not applicable; use default value.

Translatable Help Not applicable; use default value.
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Figure 3-4    Data Extension Module Fields

4. Click Save.

Configuring Currency Settings
1. Select the Enterprise, property, or zone, click Setup, and then click Currency.

2. Double-click the record for the currency used by the delivery service provider (for example,
US Dollars).

3. Enter or change the Abbreviation for the currency per the ISO 4217 currency code
standards.

See the Oracle MICROS Simphony Configuration Guide for more information on
configuring currencies.

4. Click Save.

Configuring the Language Culture
1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the language record, and then click the Miscellaneous tab.

3. Select the Locale ID, and then enter the Language Culture corresponding to the
language.

Ensure that the Language Culture is set to the appropriate value for the language. See
the Oracle MICROS Simphony Configuration Guide for more information on configuring
languages.

4. Click Save.

Creating Allergen Classes
1. Select the Enterprise level, click Descriptors, and then click Allergen Names.
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Figure 3-5    EMC Enterprise Descriptors Tab - Allergen Names

• The module has several pre-configured allergen names/codes.
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Figure 3-6    EMC Allergen Names Module

• The existing allergen names and codes cannot be edited or deleted; however the text
can be translated.

2. To insert new allergen names:
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a. Click the insert icon

on the toolbar.

b. After adding a record, click OK, and then click Save.

The system does not allow duplicate allergen names.

Figure 3-7    Inserting Allergen Names

3. Select the Enterprise level, click Configuration, and then click Allergen Classes.
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Figure 3-8    EMC Configuration Tab - Allergen Classes

4. Insert a new record and enter a name for the allergen class.

You can configure the Allergen Classes module from either table or form view. In table
view, if more than one allergen is selected, allergens are listed and comma separated.

Figure 3-9    Allergen Classes - Table View

5. Based on the allergy class’ name, select the allergen you want to include in the class.

You can select more than one allergen. Switch to form view by using the toggle icon on the
toolbar

, or double-click the record.

This is an example of an allergen class named Seafood. Each allergen selected here is
seafood related.

Chapter 3
Creating Allergen Classes

3-11



Figure 3-10    Allergen Classes - Form View

6. Create as many allergen classes as needed, and then click Save.

7. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

8. On the General tab, assign an allergen class from the drop-down list in the Allergen
Class field, and then click Save.
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Figure 3-11    Menu Item Classes - Allergen Class Field

9. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

10. Search Menu Item Definition records for items you wish to assign an allergen class.

11. On the record’s General tab, select the allergen class from the drop-down list that you
want to assign to the menu item class from the Allergen Class Override field, click OK,
and then click Save.
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Figure 3-12    Menu Item Definition - Allergen Class Override Field

Creating Menu Tags
A delivery service provider menu is a collection of Simphony menu items. Use a menu tag to
associate a Simphony menu item with the delivery provider menu. Each provider must have a
unique menu tag in Simphony. Only the menu items with these tags are visible in the delivery
provider application.

You need to have the role privilege to view, edit, add, or delete tags. See the Oracle MICROS
Simphony Configuration Guide for more information on creating roles and setting privileges for
tags in the Roles module, EMC Modules tab.

Simphony retains all tag activity (including add, edit, and delete) for use in auditing.

1. To create a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Click the insert icon
(

) on the toolbar.

c. Add a new tag record with the appropriate name (for example, Online Only), and then
click OK.

You cannot duplicate tag names.

d. Click Save.

2. To edit a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Change the tag name in the Name column.
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c. Click Save.

3. To delete a tag:

If you delete a tag that is associated with a menu item definition, the association is also
deleted.

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Highlight the tag record, click the delete icon
(

) on the toolbar, and then click Yes.

c. Click Save.

4. To associate a tag with a menu item definition, see the Oracle MICROS Simphony
Configuration Guide for instructions.

Creating Screen Look Ups for Menu Items
You can assign each menu item definition to a maximum of eight different SLUs in table view of
the Menu Item Maintenance module. Assigning multiple SLUs to a menu item allows flexibility
in building POS client pages that are customized to use dine in, carry out, and curbside to go,
and shows the menu items supported by the order type.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click
Menu Item.

2. Insert a new record, enter a name for the menu item screen look up (for example,
DinnerCarryOut) in the Record Name field, and then click OK.

3. Repeat step 2 to add more SLUs, and then click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

5. To assign a SLU, click the ellipsis point (...) button adjacent to the menu item First Name,
select the SLU, and then click OK.

To assign another SLU to the menu item, select the SLU from the SLU 2 column. You can
assign up to eight SLUs per menu item. Duplicate SLUs do not appear on the same
workstation page.

6. (Optional) To assign a SLU sort priority:

a. Double-click a menu item, and then click General.

b. Select the relevant SLU from the Touchscreen Properties section.

Use the SLU 2, SLU 3, and so on for multiple SLUs.

c. Enter a SLU Sort Priority (between 1-99) for the menu item.

Use this field when Page Design Layout option, Use Sort Priority, is enabled from the
Screen Lookup settings.

When SLU Sort Priority is used, menu items with Sort Priority 1 appear on the screen
first, followed by menu items with Sort priority 2, and so on up to Sort Priority 99, and
then finally Sort Priority 0 items. (Priority 0 means “Do not sort”; items with 0 appear at
the end of the list.) Typically the most popular menu items have Sort Priority 1 for easy
access. Items in the same SLU can belong to the same Sort Priority.
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Figure 3-13    Page Design Screen Lookup (SLU) Layout Settings

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Menu Item from the Type drop-down list, select SLU as the Property, and then
select the menu item screen lookup as the Value.

11. Select the Menu Item Display Name, and then click Save.

12. If the revenue center uses hand held POS client devices:

a. Select Dynamic SLU as the Property, and then select a menu item screen look up
group as the SLU Value.

b. Enter a non-zero value for the Visual State(s).

The application uses the Visual State value to link menu item screen look ups with
their corresponding Visual State buttons, which workstation operators use to change
the menu items that appear in the Dynamic SLU.
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c. To add more screen look ups to the Dynamic SLU, click Add.

d. Select the Menu Item Display Name, and then click Save.

e. Insert buttons for each screen look up that you added to the Dynamic SLU.

For example, if you added five screen look up groups to the Dynamic SLU, insert five
buttons.

f. Select Function from the Type drop-down list, and then select Visual State from the
Function list.

g. In the Arguments field, enter the Visual State value that you assigned to a screen
look up group in Step 12-b.

h. Click Save.

Configuring Menu Items
Delivery service provider integrations do not support combo meals or conversational ordering.

After creating menu items, add condiments to the items that need them, and then follow these
steps:

1. If necessary, update the menu tag as described in Creating Menu Tags.

2. Update and assign the SLU to the menu item as described in Assigning a SLU.

3. If necessary, update the menu item prices as described in Setting Menu Item Prices.

4. Specify the menu item name, item description, and image the customer sees when
ordering through the delivery application. See Configuring Customer-Facing Content for
more information.

5. If necessary, update the allergen class as described in Assigning Allergy Information for a
Menu Item.

6. Change the availability status of a menu item to generate a notification through the delivery
application, advising DoorDash of the menu item’s new status (unavailable or available).
These updates are immediately sent to DoorDash and will update in near real time.

Assigning a SLU

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then double-click the menu item in the list.

3. Click the General subtab.

4. In the Touchscreen Properties section, select the relevant SLU from the drop-down lists in
SLU through SLU 8.

You can assign up to eight SLUs per menu item. The SLU number specifies the order in
which SLUs appear on the delivery provider ordering site (from least to greatest number).
For example, a menu item assigned to SLU 2 will appear in the Entrees category:

1 Starters

2 Entrees

3 Desserts

5. Click Save.
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Setting Menu Item Prices

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Prices subtab.

4. Set the menu item price in the Price column.

If the menu item has multiple prices associated with different menu levels, ensure that
each level has an appropriate prefix configured. See the Oracle MICROS Simphony
Configuration Guide for information on setting main, sub, and custom menu levels.

5. Click Save.

Configuring Customer-Facing Content

Specify the menu item name, description, and image that customers see in the delivery
provider application when placing an order.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Images subtab.

4. Enter or change the Consumer Item Name.

5. Enter or change the Consumer Item Description.

6. In the Image 1 section, click Upload to select the image and upload it to Simphony.

7. (Optional) Enter or change the image Title.

8. (Optional) Enter or change the image Comments.

9. Enter the URL that links to the image.

10. Click Save.

Assigning Allergy Information for a Menu Item
When using DoorDash, you have the option to include allergen information for a menu item on
the delivery service provider application.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the General subtab.

4. In the Allergen Class Override field, click Select, select the allergen class, and then click
OK.

5. Click Save.
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Configuring Combo Meals
Simple combo meals are supported with DoorDash; sized combo meals are not supported with
delivery service providers.Complete the Simphony combo meal configuration described in 
Combo and Fixed Price Meals in the Oracle MICROS Simphony Configuration Guide, but do
not configure sized combo meals.

The following configuration is required to synchronize combo meals from Simphony to delivery
providers through delivery connectors:

1. Create Combo Meal Groups.

If condiment items (not parents) are included as part of a combo group, these items are
ignored during the menu synchronization.

See Creating Combo Meal Groups in the Oracle MICROS Simphony Configuration Guide
for more information.

2. Tag the corresponding Menu Item Master.

To include a combo in the synchronization process, the corresponding Menu Item Master
must be tagged. Items within a combo group do not need individual tags. However, if items
within a combo group are tagged individually, they appear on the delivery service provider
UI as both part of the combo and as individual à la carte items.

See Configuring Menu Tag Groups and Tags in the Oracle MICROS Simphony
Configuration Guide for more information.

Review and understand the following considerations before attempting to synchronize combos
with the delivery service provider. Ensure that your combo meal configurations adhere to these
guidelines to ensure a smooth and accurate synchronization process.

Table 3-2    Combo Meal Setup Guidelines

Simphony Considerations Description for use with Delivery Connectors

3 - Is Sized Combo Meal option If selected, and the combo meal contains
configuration consistent with sized combos, it is
ignored by the synchronization.
If a combo meal is configured as sized but does
not contain items with size specifications, it is
treated as unsized and included in the
synchronization.
See Creating Combo Meals.

Combo Group Items with Sizes in Unsized
Combos

If a combo group item has a size specification
within an unsized combo meal, it appears on
the delivery service provider UI but is treated
as unsized.
See Creating Combo Meal Groups.
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Table 3-2    (Cont.) Combo Meal Setup Guidelines

Simphony Considerations Description for use with Delivery Connectors

Prices You can set prices for combo meals at the Menu
Item Master level, by combo group, or by
combo group item. It is recommended to set
base prices for combo meals at the Menu Item
Master level. Prices set directly on the combo
item definition are ignored. Ensure that prices
are defined for all items within a combo group
to avoid default prices of $0.00.
If the Price is not specified, Active On Level 1
is used by default.
See Combo Meal Group Pricing and Creating
Combo Meal Groups.

Alternate Groups Combo group items cannot be members of
Alternate Groups; Alternate Groups are not
supported with delivery service provider
combos.
See Creating Combo Meal Groups.

Side Count and Quantity The side count for combo groups can be
configured and is controlled in the side count
area of the Combo Group. The default count is
1.

The quantity of items within a combo group,
including modifiers or weighed items, is
controlled in the Combo Group Item area.
DoorDash only supports a quantity of 1.

If the delivery service provider detects a combo
group item with a quantity greater than 1 for
DoorDash, the combo is ignored, and an error
is logged. DoorDash has a limitation where the
quantity selector is limited to 1 when a menu
item in a combo group has modifiers.
See Creating Combo Meal Groups.

Combo Meal Groups Based on Menu Item
Definition

Only Menu Item Definition 1 is supported for
combos.

Invalid Items in Combo Groups If a combo meal group does not contain valid
items, it is unable to be ordered. Invalid items
include condiments and items without
definitions.

Condiment Parent as Menu Item Master If a condiment parent is configured as a Menu
Item Master, its condiment groups are ignored,
and it is treated as a regular menu item.

Duplicate Combo Meal Groups If a combo meal group is referenced multiple
times in a combo meal, the duplicates are
ignored, and only one instance of the group is
considered.
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Configuring Advanced Menu Item Options
When considering the display of menu items on delivery platform ordering sites and kiosks,
additional menu item options are available. The modifiers and prices used in Simphony POS
Operations may not be the same as those displayed to delivery platform customers on online
ordering sites or kiosks.

You can create additional menu item definitions (see Configuring Menu Item Definitions in the
Oracle MICROS Simphony Configuration Guide), or set Delivery Connector advanced menu
item configurations options. These advanced options are controlled in revenue centers and in
JSON code, and are as follows for DoorDash:

Price Sequence Level Filter
The price sequence filter lets you specify the menu item price sequence levels used in the
delivery service provider. You can apply the price sequence filter to base menu items (for
example, a hamburger) and to condiments (for example, cheese). This filter affects all menu
items that are passed to the delivery service provider.

See Sample JSON: DoorDash Single Menu and Sample JSON: DoorDash Multiple Menus for
descriptions of JSON data values and code samples that you can copy and change for your
restaurant.

Condiment Group Filter
The condiment group filter lets you specify the condiment groups for each delivery service
provider. The filter allows the condiment groups in the Menu Item Classes module to be
included or excluded. This prevents unwanted condiments and condiment groups from being
displayed on the delivery service provider ordering site.

To specify the condiment group filter in the JSON code, set condiment group numbers
separated by commas, and true or false to indicate whether the condiment group specified
will be included or excluded from the delivery service provider.

See Sample JSON: DoorDash Single Menu and Sample JSON: DoorDash Multiple Menus for
descriptions of JSON data values and code samples that you can copy and change for your
restaurant.

Image Slot
If multiple image slots are in use for an organization, the item image slot lets you specify which
menu item image slot is used for the product display in the delivery service provider, rather
than the default setting of 1. This feature is used with kiosks and online ordering sites.

See Sample JSON: DoorDash Single Menu and Sample JSON: DoorDash Multiple Menus for
descriptions of JSON data values and code samples that you can copy and change for your
restaurant.

SLU Slot
The Screen Look Up (SLU) slot lets you specify which SLU slot is used for the product display
in delivery service providers. By default, the system shows all SLUs assigned to a menu item
as categories in the delivery service provider. If multiple SLUs are in use for an organization,
the SLU slots appear as multiple categories with the source product displayed in each SLU.
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The selection allows customers to specify the SLU name to use as a category name in their
delivery service provider.

See Sample JSON: DoorDash Single Menu and Sample JSON: DoorDash Multiple Menus for
descriptions of JSON data values and code samples that you can copy and change for your
restaurant.

Using Default Condiments with DoorDash
If you have default condiments configured for a menu item in Simphony, you can pass them to
DoorDash without having to create additional Menu Item Classes and condiment groups.

1. If the condiment group is configured as a Default Condiment master group in the Menu
Item Classes module, these condiments display as removable option in the delivery
platform.

2. If the condiment group is not configured as a Default Condiment master group in the Menu
Item Classes module, the condiments display as selected items for the menu item, and
must be disabled to remove them.

The condiment group configuration affects the way Default Condiments display on a Kitchen
Display System (KDS) and on order receipts.

• In the case of #1, a Hamburger menu item with Lettuce, Tomato, and Pickle as the Default
Condiment master group displays as Hamburger, no, Lettuce

• In the case of #2, a menu item with lettuce, tomato, and pickle as the Default Condiment
master group displays as Hamburger, Tomato, Pickle

KDS Notification
When menu items are bumped from the KDS, a notification is sent to the customer and to the
delivery driver indicating that the ordered items have been completed in the kitchen.

Creating Delivery Configuration in the Revenue Center
Configuration for delivery service provider platform integrations is specified in EMC through the
Data Extensions column named DeliveryPlatformConfigurationData, which is added to the
revenue center table, populated with the JSON representation of the data structure.

1. Select the property, click Setup, and then click RVC Configuration.

2. Double-click the revenue center, and then click the Data Extensions tab.

3. In the Column field, locate DeliveryPlatformConfigurationData, and then click Edit
Json.

4. Enter JSON configuration data and then click OK.

See Sample JSON: DoorDash Single Menu and Sample JSON: DoorDash Multiple Menus
for descriptions of JSON data values and code samples that you can copy and change for
your restaurant. After you change the sample values, you can copy your restaurant code
into the DeliveryPlatformConfigurationData column to complete this step.

5. Click Save.

Sample JSON: DoorDash Single Menu
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The following sample shows JSON code using DoorDash with a single menu. The tables that
follow the code sample describe the values in the code.

Tip:

Click Copy to copy the code to your clipboard and then paste it into a text editor such
as Notepad++. Change the values for your restaurant and then copy your code into
the DeliveryPlatformConfigurationData column as described in Creating Delivery
Configuration in the Revenue Center.

{
    "deliveryPlatformConfigurations": [
         {
            "name": "DoorDash",
            "groupIdentifier": null,
            "rvcIdentifier": "24219649",
            "empNum": 45,
            "otNum": 5,
            "tendNum": 101,
            "priceSequences": 
                [
                {
                "type": "BaseItem",
                "levels": [2]
                },
                {
                "type": "Condiment",
                "levels": [6, 7, 8]
                }
                ]
            "condimentGroupRuleFilter": 
                {
                "values": "1,2,3,4",
                "include": true
                }
            "itemImageSlot": 2
            "sluSlot": 1
            "menus": [
                    {
                    "name": {
                        "en-US": "SampleMenu"
                    },
                    "identifier": "DoorDashMenu",
                    "imageURL": "https://objectstorage.png",
                    "availability": [{
                            "dayOfWeek": "Mon",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Tue",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
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                        {
                            "dayOfWeek": "Wed",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Thu",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Fri",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sat",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sun",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        }
                    ],
                                                        "specialHours":
                        [
                         {
                        "date": "2022-12-31",
                        "closed": true,
                        "start_time": "04:00",
                        "end_time": "08:00"
                         }
                        ]
                }
            ]
                    }
    ]
}

Table 3-3    Data Extensions Column Name

Name Type Description

deliveryPlatformConfiguration
s

DeliveryPlatformConfiguratio
n[]

Revenue center’s integration
configuration for each
applicable delivery platform.

Table 3-4    Delivery Platform Configuration

Name Type Description

name string DoorDash
Do not change this value.
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Table 3-4    (Cont.) Delivery Platform Configuration

Name Type Description

groupIdentifier string Set to null because the object
does not apply to DoorDash.

rvcIdentifier string Identifier for the revenue
center. This is the Site ID
obtained during the
registration process.

empNum number Object number for employee to
be used to enter orders
received from the delivery
platform.

otNum number Object number for Order Type
to be used for orders received
from the delivery platform.

remakeOtNum number Set to -1 because the object is
not valid for DoorDash. Do not
change this value.

tendNum number Object number for Tender
Media to be used to settle
orders received from the
delivery platform.

priceSequences string
number

Type of base menu item and
condiment (optional).
Number is the price level.

condimentGroupRuleFilter number
true/false

Numbers separated by
commas. Numbers are the
condiment groups.
True directs the application to
use the numbers listed. False
excludes the numbers listed.

itemImageSlot number Menu item image slot number
used for the product display in
the delivery platform.

sluSlot number Menu item SLU slot number
used for the product display in
the delivery platform.

menus DeliveryPlatformMenu[] Details for menu(s) to be
submitted to the delivery
platform.
Make sure to follow any
limitations imposed by the
delivery platform on the
number of menus.

Table 3-5    Delivery Platform Menu

Name Type Description

name TranslatedString Display name for menu by
locale.
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Table 3-5    (Cont.) Delivery Platform Menu

Name Type Description

identifier string Identifier for menu to be used
in tags.
Make sure the identifier does
not conflict with tags used for
other purposes.

imageURL string URL for image associated with
menu.
Upload the menu image to the
Oracle Object Store through a
dummy menu item.

availability ServicePeriod[] Start and end times for each
day of the week that the menu
is to be made available.

Table 3-6    Translated String

Name Type Description

<locale code> string String translation for given
locale.

… … …

Table 3-7    Service Period

Name Type Description

dayOfWeek string First three letters of day of
week for service period.

startTime string Start time for service period, in
24-hour (hh:mm) format.

endTime string End time for service period, in
24-hour (hh:mm) format.
End time must be later than
start time.

Sample JSON: DoorDash Multiple Menus

The following sample shows JSON code using DoorDash with multiple menus. The tables that
follow the code sample describe the values in the code.
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Tip:

Click Copy to copy the code to your clipboard and then paste it into a text editor such
as Notepad++. Change the values for your restaurant and then copy your code into
the DeliveryPlatformConfigurationData column as described in Creating Delivery
Configuration in the Revenue Center.

{
    "deliveryPlatformConfigurations": [
         {
            "name": "DoorDash",
            "groupIdentifier": null,
            "rvcIdentifier": "ba029dd5-a533-4201-a67a-4b3f992844d7",
            "empNum": 17,
            "otNum": 6,
            "tendNum": 5,
            "priceSequences": 
                [
                {
                "type": "BaseItem",
                "levels": [2]
                },
                {
                "type": "Condiment",
                "levels": [6, 7, 8]
                }
                ]
            "condimentGroupRuleFilter": 
                {
                "values": "1,2,3,4",
                "include": true
                }
            "itemImageSlot": 2
            "sluSlot": 1
            "menus": [
                    {
                    "name": {
                        "en-US": "BreakfastDD"
                    },
                    "identifier": "DoorDash",
                    "imageURL": "https://objectstorage.jpg",
                    "availability": [{
                            "dayOfWeek": "Mon",
                            "startTime": "02:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Tue",
                            "startTime": "04:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Wed",
                            "startTime": "07:00",
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                            "endTime": "09:59"
                        },
                        {
                            "dayOfWeek": "Thu",
                            "startTime": "08:00",
                            "endTime": "11:59"
                        },
                        {
                            "dayOfWeek": "Fri",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sat",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sun",
                            "startTime": "12:00",
                            "endTime": "23:59"
                        }
                    ]
                },
                {
                    "name": {
                        "en-US": "LunchDD"
                    },
                    "identifier": "DoorDash2",
                    "imageURL": "https://objectstorage.us-
ashburn-1.oraclecloud.com/n/idvvfekwvhut/b/bt-sim-200707075021-Ram/o/
Ram200707075020060.jpg",
                    "availability": [{
                            "dayOfWeek": "Mon",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Tue",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Wed",
                            "startTime": "12:15",
                            "endTime": "14:59"
                        },
                        {
                            "dayOfWeek": "Thu",
                            "startTime": "12:15",
                            "endTime": "15:30"
                        },
                        {
                            "dayOfWeek": "Fri",
                            "startTime": "00:00",
                            "endTime": "23:59"
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                        },
                        {
                            "dayOfWeek": "Sat",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sun",
                            "startTime": "12:00",
                            "endTime": "23:59"
                        }
                    ]
                },
                {
                    "name": {
                        "en-US": "DinnerDD"
                    },
                    "identifier": "DoorDash3",
                    "imageURL": "https://objectstorage.us-
ashburn-1.oraclecloud.com/n/idvvfekwvhut/b/bt-sim-200707075021-Ram/o/
Ram200707075020060.jpg",
                    "availability": [{
                            "dayOfWeek": "Mon",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Tue",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Wed",
                            "startTime": "19:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Thu",
                            "startTime": "19:00",
                            "endTime": "22:30"
                        },
                        {
                            "dayOfWeek": "Fri",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sat",
                            "startTime": "00:00",
                            "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sun",
                            "startTime": "12:00",
                            "endTime": "23:59"
                        }
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                    ],
                                        "specialHours":
                        [
                         {
                        "date": "2022-06-27",
                        "closed": true,
                        "start_time": "04:00",
                        "end_time": "08:00"
                         }
                        ]
                }
            ]
                    }
    ]
}

Table 3-8    Data Extensions Column Name

Name Type Description

deliveryPlatformConfiguration
s

DeliveryPlatformConfiguratio
n[]

Revenue center’s integration
configuration for each
applicable delivery platform.

Table 3-9    Delivery Platform Configuration

Name Type Description

name string DoorDash
Do not change this value.

groupIdentifier string Set to null because the object
does not apply to DoorDash.

rvcIdentifier string Identifier for the revenue
center. This is the Site ID
obtained during the
registration process.

empNum number Object number for employee to
be used to enter orders
received from the delivery
platform.

otNum number Object number for Order Type
to be used for orders received
from the delivery platform.

remakeOtNum number Set to -1 because the object is
not valid for DoorDash. Do not
change this value.

tendNum number Object number for Tender
Media to be used to settle
orders received from the
delivery platform.

priceSequences string
number

Type of base menu item and
condiment (optional).
Number is the price level.
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Table 3-9    (Cont.) Delivery Platform Configuration

Name Type Description

condimentGroupRuleFilter number
true/false

Numbers separated by
commas. Numbers are the
condiment groups.
True directs the application to
use the numbers listed. False
excludes the numbers listed.

itemImageSlot number Menu item image slot number
used for the product display in
the delivery platform.

sluSlot number Menu item SLU slot number
used for the product display in
the delivery platform.

menus DeliveryPlatformMenu[] Details for menu(s) to be
submitted to the delivery
platform.
Make sure to follow any
limitations imposed by the
delivery platform on the
number of menus.

Table 3-10    Delivery Platform Menu

Name Type Description

name TranslatedString Display name for menu by
locale.

identifier string Identifier for menu to be used
in tags.
Make sure the identifier does
not conflict with tags used for
other purposes.

imageURL string URL for image associated with
menu.
Upload the menu image to the
Oracle Object Store through a
dummy menu item.

availability ServicePeriod[] Start and end times for each
day of the week that the menu
is to be made available.

Table 3-11    Translated String

Name Type Description

<locale code> string String translation for given
locale.

… … …
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Table 3-12    Service Period

Name Type Description

dayOfWeek string First three letters of day of
week for service period.

startTime string Start time for service period, in
24-hour (hh:mm) format.

endTime string End time for service period, in
24-hour (hh:mm) format.
End time must be later than
start time.

Activating the Delivery Service Provider Interface

WARNING:

Ensure that all configuration has been completed before activating the delivery
platform.

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Interfaces tab, and then select Delivery Platform Integrations.

3. In the Delivery Platform Integrations section, select the delivery platform to enable it.

If you no longer use a delivery platform, disable it.

4. Click Save.

One hour after activation of the Delivery Platform Integrations option, the store will be
visible and ready for ordering on the delivery service provider website.

Verifying Setup
After configuring Simphony, wait an hour and then go to the delivery service website. Verify the
following information:

1. The latest menu is synced to the website. Preview the menu using the following URL: 
https://www.doordash.com/store/{storeid}.

2. Once the menu is synced to the website, reply to the DoorDash email and confirm that the
store can go live.

3. Once the store is live, place an order, and then confirm that the check is printed in the
kitchen.
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4
Rappi

Rappi is supported with Simphony release 19.4 and later. Review the following checklist before
you set up Simphony for Rappi:

• Decide on your menu. Rappi supports one menu.

• Decide on unique tag names for the menu.

• Plan the list of menu items.

• Determine menu availability. For example, will the menu be available only on weekdays
between specific times?

• The menu can have multiple categories but must have at least one category. A category is
a group of similar menu items. For example, you can have a lunch menu with categories
for salads, sandwiches, and desserts.

In Simphony, a category corresponds to a SLU. Each category needs its own SLU.

Note:

Rappi supports a maximum of 100 SLUs.

• Decide on an image to display the menu. This is optional.

• Consider the following characteristics of each menu item:

– Customer-facing menu item name

– Customer-facing menu item description

– Menu item image that meets the following specifications:

* JPEG or PNG file format

* Pixel size of 1920 x 1080

* Aspect ratio of 16:9

Note:

All images are manually verified by Rappi and will not appear immediately on
the ordering site.

– Menu item price

– Allergen classes

• Consider the display of menu items on delivery platform ordering sites and kiosks, and
determine whether advanced menu options are needed:

– Price sequence level filter

– Condiment group filter

– Image slot
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– SLU slot

Registering with Rappi
Complete the following steps if you do not have a Rappi account.

1. Register with Rappi at https://partners.rappi.com/.

2. Specify that you will be integrating with Oracle MICROS.

3. You will receive store IDs for each store created.

Transaction Services Generation 2
The delivery service provider integration requires Simphony Transaction Services Generation 2
(STS Gen2).

For locations that will integrate with delivery service providers, follow these steps to either
enable STS Gen2 for the first time, or confirm that it is set up correctly.

Configuring Workstations
Add a SimphonyTransaction Services Generation 2 (STS Gen2) workstation or validate that an
existing STS Gen2 workstation is configured for each location. The STS Gen2 workstation
must be a CAPS Service Host and the Type must be POS API Client.

If you have more than one POS API Client workstation type available in a revenue center,
Oracle Food and Beverage recommends enabling at least two workstation devices that can
receive checks and orders as this will provide resiliency should one of the workstations
become unavailable.

1. Log in to EMC.

2. Select the location (property), click Setup, and then click Workstations.

3. If you do not see an STS Gen2 workstation in the list that is a CAPS Service Host with
Type POS API Client, follow these steps:

a. Locate the workstation record with the Check and Posting Service (CAPS), and then
double-click the column number to the left of this workstation record to open it.

The CAPS workstation record is usually the first one listed.

b. Click the Service Host tab, and confirm that the Type value shows Check and
Posting (CAPS).

c. Select the CAPS workstation in the list in the left pane, and then click the General tab.

d. Click the insert icon
(

) on the toolbar.

e. Enter STSCAPS in the Record Name field, and then click OK.

f. Click the General tab, and then select 3 - POS API Client from the Type drop-down
list.

g. In the General Settings section, select Enable Simphony Transaction Services (Gen
2) Cloud API.
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h. Confirm that the Type value shows 3 - POS API Client.

i. In the Service Host ID field, select the Service Host that is running CAPS.

j. Click the Order Devices tab, and then enable the order devices on which online
orders will print.

k. Click the Transactions tab, and then select the Default Order Type for the
workstation.

l. Click the Revenue Centers tab, and then select the revenue center from the drop-
down list.

m. Click Save.

Configuring Revenue Center Parameters
1. Log in to EMC.

2. Select the revenue center, click Setup, and then click RVC Parameters.

3. Click the Options tab, and then enable 74 - Enable Simphony Transaction Services
Gen 2.

Figure 4-1    RVC Parameters Options

4. Click Save.

Creating Tender Media
You need to create a dedicated tender record for each delivery service provider. These tender
records are used when posting delivery service provider orders. The tenders can be set up to
process online orders.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a tender record for each food delivery order, enter the name (for example,
UberEatsAccount, PostmatesAccount, DeliverooAccount, DoorDashAccount,
GlovoAccount, RappiAccount, and so on), and then click OK.

3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.
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5. Click the Options tab, and then click the Ops Behavior subtab.

6. Select 3 - Assume Paid in Full.

7. Click Save.

Creating Order Types
Create an order type for each delivery service provider you do business with. See the Oracle
MICROS Simphony Configuration Guide for more information on configuring order types.
When creating the order type, keep these points in mind:

• Name the order type after the delivery service provider.

• Tax is not billed to delivery service provider orders. The delivery service provider collects
taxes from the customer. In the Order Type Parameters module, do not select any tax rates
in the Tax Masks column.

• Use a separate order type for remake orders.

While it is possible to use existing order types with each delivery service provider, configuring
an order type specifically for each delivery service provider makes it easier to track the orders
for that delivery service provider in the kitchen and on reports.

Configuring an Open Discount
Configure an open dollar discount for Rappi, which is used for promotions. See Configuring
Discounts in the Oracle MICROS Simphony Configuration Guide for detailed instructions. In
the Discounts module, General tab of the EMC, name the discount after the delivery service
provider (for example, RappiDiscount), set the Condiment Discountability to 4 - Parent and
All Condiment Items, and enable the discount option 1 - ON = Open; OFF = Preset.

Creating a Rappi Employee
Rappi orders enter Simphony using an employee configured for this purpose. Configuring a
dedicated employee record for Rappi orders allows you to track these orders.

See the Oracle MICROS Simphony Configuration Guide for more information on configuring
the transaction services default employee and how to create the employee record.

After adding the employee, record the value shown in the # field of the Employee Maintenance
module. The delivery configuration in the revenue center requires the POS employee object
number (shown in the # field) when configuring the JSON file in a later section of Rappi
configuration.

Adding a Data Extension Record
1. Select the Enterprise, click Configuration, and then click Data Extensions.

Chapter 4
Creating Order Types

4-4



Figure 4-2    EMC Enterprise Main Menu

2. Click the Insert  icon on the toolbar to add a record, enter the Data Extension record
name, and then click OK.

Figure 4-3    EMC Enterprise Main Menu

3. Enter information in the following fields:

Table 4-1    Data Extension Fields

Field Description

Table Select 20 - Revenue Center.

Extra Column Name Enter DeliveryPlatformConfigurationData.

Type Select 12 - Json.
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Table 4-1    (Cont.) Data Extension Fields

Field Description

Data Constraints Select Max Chars: 9999.

Sort Priority Not applicable; use default value.

Display Width Enter 150.

Translatable Name Not applicable; use default value.

Translatable Help Not applicable; use default value.

Figure 4-4    Data Extension Module Fields

4. Click Save.

Configuring Currency Settings
1. Select the Enterprise, property, or zone, click Setup, and then click Currency.

2. Double-click the record for the currency used by the delivery service provider (for example,
US Dollars).

3. Enter or change the Abbreviation for the currency per the ISO 4217 currency code
standards.

See the Oracle MICROS Simphony Configuration Guide for more information on
configuring currencies.

4. Click Save.

Configuring the Language Culture
1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the language record, and then click the Miscellaneous tab.

3. Select the Locale ID, and then enter the Language Culture corresponding to the
language.
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Ensure that the Language Culture is set to the appropriate value for the language. See
the Oracle MICROS Simphony Configuration Guide for more information on configuring
languages.

4. Click Save.

Creating Allergen Classes
1. Select the Enterprise level, click Descriptors, and then click Allergen Names.

Figure 4-5    EMC Enterprise Descriptors Tab - Allergen Names

• The module has several pre-configured allergen names/codes.
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Figure 4-6    EMC Allergen Names Module

• The existing allergen names and codes cannot be edited or deleted; however the text
can be translated.

2. To insert new allergen names:
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a. Click the insert icon

on the toolbar.

b. After adding a record, click OK, and then click Save.

The system does not allow duplicate allergen names.

Figure 4-7    Inserting Allergen Names

3. Select the Enterprise level, click Configuration, and then click Allergen Classes.
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Figure 4-8    EMC Configuration Tab - Allergen Classes

4. Insert a new record and enter a name for the allergen class.

You can configure the Allergen Classes module from either table or form view. In table
view, if more than one allergen is selected, allergens are listed and comma separated.

Figure 4-9    Allergen Classes - Table View

5. Based on the allergy class’ name, select the allergen you want to include in the class.

You can select more than one allergen. Switch to form view by using the toggle icon on the
toolbar

, or double-click the record.

This is an example of an allergen class named Seafood. Each allergen selected here is
seafood related.
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Figure 4-10    Allergen Classes - Form View

6. Create as many allergen classes as needed, and then click Save.

7. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

8. On the General tab, assign an allergen class from the drop-down list in the Allergen
Class field, and then click Save.
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Figure 4-11    Menu Item Classes - Allergen Class Field

9. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

10. Search Menu Item Definition records for items you wish to assign an allergen class.

11. On the record’s General tab, select the allergen class from the drop-down list that you
want to assign to the menu item class from the Allergen Class Override field, click OK,
and then click Save.
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Figure 4-12    Menu Item Definition - Allergen Class Override Field

Creating Menu Tags
A delivery service provider menu is a collection of Simphony menu items. Use a menu tag to
associate a Simphony menu item with the delivery provider menu. Each provider must have a
unique menu tag in Simphony. Only the menu items with these tags are visible in the delivery
provider application.

You need to have the role privilege to view, edit, add, or delete tags. See the Oracle MICROS
Simphony Configuration Guide for more information on creating roles and setting privileges for
tags in the Roles module, EMC Modules tab.

Simphony retains all tag activity (including add, edit, and delete) for use in auditing.

1. To create a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Click the insert icon
(

) on the toolbar.

c. Add a new tag record with the appropriate name (for example, Online Only), and then
click OK.

You cannot duplicate tag names.

d. Click Save.

2. To edit a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Change the tag name in the Name column.
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c. Click Save.

3. To delete a tag:

If you delete a tag that is associated with a menu item definition, the association is also
deleted.

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Highlight the tag record, click the delete icon
(

) on the toolbar, and then click Yes.

c. Click Save.

4. To associate a tag with a menu item definition, see the Oracle MICROS Simphony
Configuration Guide for instructions.

Creating Screen Look Ups for Menu Items
You can assign each menu item definition to a maximum of eight different SLUs in table view of
the Menu Item Maintenance module. Assigning multiple SLUs to a menu item allows flexibility
in building POS client pages that are customized to use dine in, carry out, and curbside to go,
and shows the menu items supported by the order type.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click
Menu Item.

2. Insert a new record, enter a name for the menu item screen look up (for example,
DinnerCarryOut) in the Record Name field, and then click OK.

3. Repeat step 2 to add more SLUs, and then click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

5. To assign a SLU, click the ellipsis point (...) button adjacent to the menu item First Name,
select the SLU, and then click OK.

To assign another SLU to the menu item, select the SLU from the SLU 2 column. You can
assign up to eight SLUs per menu item. Duplicate SLUs do not appear on the same
workstation page.

6. (Optional) To assign a SLU sort priority:

a. Double-click a menu item, and then click General.

b. Select the relevant SLU from the Touchscreen Properties section.

Use the SLU 2, SLU 3, and so on for multiple SLUs.

c. Enter a SLU Sort Priority (between 1-99) for the menu item.

Use this field when Page Design Layout option, Use Sort Priority, is enabled from the
Screen Lookup settings.

When SLU Sort Priority is used, menu items with Sort Priority 1 appear on the screen
first, followed by menu items with Sort priority 2, and so on up to Sort Priority 99, and
then finally Sort Priority 0 items. (Priority 0 means “Do not sort”; items with 0 appear at
the end of the list.) Typically the most popular menu items have Sort Priority 1 for easy
access. Items in the same SLU can belong to the same Sort Priority.
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Figure 4-13    Page Design Screen Lookup (SLU) Layout Settings

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Menu Item from the Type drop-down list, select SLU as the Property, and then
select the menu item screen lookup as the Value.

11. Select the Menu Item Display Name, and then click Save.

12. If the revenue center uses hand held POS client devices:

a. Select Dynamic SLU as the Property, and then select a menu item screen look up
group as the SLU Value.

b. Enter a non-zero value for the Visual State(s).

The application uses the Visual State value to link menu item screen look ups with
their corresponding Visual State buttons, which workstation operators use to change
the menu items that appear in the Dynamic SLU.
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c. To add more screen look ups to the Dynamic SLU, click Add.

d. Select the Menu Item Display Name, and then click Save.

e. Insert buttons for each screen look up that you added to the Dynamic SLU.

For example, if you added five screen look up groups to the Dynamic SLU, insert five
buttons.

f. Select Function from the Type drop-down list, and then select Visual State from the
Function list.

g. In the Arguments field, enter the Visual State value that you assigned to a screen
look up group in Step 12-b.

h. Click Save.

Configuring Menu Items
Delivery service provider integrations do not support combo meals or conversational ordering.

After creating menu items, add condiments to the items that need them, and then follow these
steps:

1. If necessary, update the menu tag as described in Creating Menu Tags.

2. Update and assign the SLU to the menu item as described in Assigning a SLU.

3. If necessary, update the menu item prices as described in Setting Menu Item Prices.

4. Specify the menu item name, item description, and image the customer sees when
ordering through the delivery application. See Configuring Customer-Facing Content for
more information.

5. If necessary, update the allergen class as described in Assigning Allergy Information for a
Menu Item.

6. Change the availability status of a menu item to generate a notification through the delivery
application, advising Rappi of the menu item’s new status (unavailable or available). These
updates are immediately sent to Rappi and will update in near real time.

Assigning a SLU

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then double-click the menu item in the list.

3. Click the General subtab.

4. In the Touchscreen Properties section, select the relevant SLU from the drop-down lists in
SLU through SLU 8.

You can assign up to eight SLUs per menu item. The SLU number specifies the order in
which SLUs appear on the delivery provider ordering site (from least to greatest number).
For example, a menu item assigned to SLU 2 will appear in the Entrees category:

1 Starters

2 Entrees

3 Desserts

5. Click Save.
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Setting Menu Item Prices

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Prices subtab.

4. Set the menu item price in the Price column.

If the menu item has multiple prices associated with different menu levels, ensure that
each level has an appropriate prefix configured. See the Oracle MICROS Simphony
Configuration Guide for information on setting main, sub, and custom menu levels.

5. Click Save.

Configuring Customer-Facing Content

Specify the menu item name, description, and image that customers see in the delivery
provider application when placing an order.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Images subtab.

4. Enter or change the Consumer Item Name.

5. Enter or change the Consumer Item Description.

6. In the Image 1 section, click Upload to select the image and upload it to Simphony.

7. (Optional) Enter or change the image Title.

8. (Optional) Enter or change the image Comments.

9. Enter the URL that links to the image.

10. Click Save.

Assigning Allergy Information for a Menu Item
When using Rappi, you have the option to include allergen information for a menu item on the
delivery service provider application.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the General subtab.

4. In the Allergen Class Override field, click Select, select the allergen class, and then click
OK.

5. Click Save.
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Configuring Advanced Menu Item Options
When considering the display of menu items on delivery platform ordering sites and kiosks,
additional menu item options are available. The modifiers and prices used in Simphony POS
Operations may not be the same as those displayed to delivery platform customers on online
ordering sites or kiosks.

You can create additional menu item definitions (see Configuring Menu Item Definitions in the
Oracle MICROS Simphony Configuration Guide), or set Delivery Connector advanced menu
item configurations options. These advanced options are controlled in revenue centers and in
JSON code, and are as follows for Rappi:

Price Sequence Level Filter
The price sequence filter lets you specify the menu item price sequence levels used in the
delivery service provider. You can apply the price sequence filter to base menu items (for
example, a hamburger) and to condiments (for example, cheese). This filter affects all menu
items that are passed to the delivery service provider.

See Sample JSON: Rappi for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

Condiment Group Filter
The condiment group filter lets you specify the condiment groups for each delivery service
provider. The filter allows the condiment groups in the Menu Item Classes module to be
included or excluded. This prevents unwanted condiments and condiment groups from being
displayed on the delivery service provider ordering site.

To specify the condiment group filter in the JSON code, set condiment group numbers
separated by commas, and true or false to indicate whether the condiment group specified
will be included or excluded from the delivery service provider.

See Sample JSON: Rappi for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

Image Slot
If multiple image slots are in use for an organization, the item image slot lets you specify which
menu item image slot is used for the product display in the delivery service provider, rather
than the default setting of 1. This feature is used with kiosks and online ordering sites.

See Sample JSON: Rappi for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

SLU Slot
The Screen Look Up (SLU) slot lets you specify which SLU slot is used for the product display
in delivery service providers. By default, the system shows all SLUs assigned to a menu item
as categories in the delivery service provider. If multiple SLUs are in use for an organization,
the SLU slots appear as multiple categories with the source product displayed in each SLU.
The selection allows customers to specify the SLU name to use as a category name in their
delivery service provider.
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See Sample JSON: Rappi for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

Creating Delivery Configuration in the Revenue Center
Configuration for delivery service provider platform integrations is specified in EMC through the
Data Extensions column named DeliveryPlatformConfigurationData, which is added to the
revenue center table, populated with the JSON representation of the data structure.

1. Select the property, click Setup, and then click RVC Configuration.

2. Double-click the revenue center, and then click the Data Extensions tab.

3. In the Column field, locate DeliveryPlatformConfigurationData, and then click Edit
Json.

4. Enter JSON configuration data and then click OK.

See Sample JSON: Rappi for descriptions of JSON data values and code samples that
you can copy and change for your restaurant. After you change the sample values, you
can copy your restaurant code into the DeliveryPlatformConfigurationData column to
complete this step.

5. Click Save.

Sample JSON: Rappi

The following sample shows JSON code for Rappi. The tables that follow the code sample
describe the values in the code.

Tip:

Click Copy to copy the code to your clipboard and then paste it into a text editor such
as Notepad++. Change the values for your restaurant and then copy your code into
the DeliveryPlatformConfigurationData column as described in Creating Delivery
Configuration in the Revenue Center.

{
    "deliveryPlatformConfigurations": [
         {
            "name": "Rappi",
            "groupIdentifier": "",
            "rvcIdentifier": "1930052575",
            "empNum": 2,
            "otNum": 1,
            "tendNum": 150,
            "priceSequences": 
                [
                {
                "type": "BaseItem",
                "levels": [2] 
                },
                {
                "type": "Condiment",
                "levels": [6, 7, 8] 
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                }
                ]
            "condimentGroupRuleFilter": 
                {
                "values": "1,2,3,4", 
                "include": true
                }
            "itemImageSlot": 2
            "sluSlot": 1
            "discountId": 1,
            "countryBaseUrl": "https://microservices.dev.rappi.com", //Rappi 
country base URL. Refer to https://dev-portal.rappi.com/getting-started/
#country-domains
            "menus": [
                {
                    "name": {
                        "en-US": "MenuTitle"
                    },
                    "identifier": "Rappi",
                    "imageURL": "https://via.placeholder.com/201",
                }

Table 4-2    Data Extensions Column Name

Name Type Description

deliveryPlatformConfiguration
s

DeliveryPlatformConfiguratio
n[]

Revenue center’s integration
configuration for each
applicable delivery platform.

Table 4-3    Delivery Platform Configuration

Name Type Description

name string Rappi
Do not change this value.

groupIdentifier string Set to null because the object
does not apply to Rappi.

rvcIdentifier string Identifier for the revenue
center. This is the Site ID
obtained during the
registration process.

empNum number Object number for employee to
be used to enter orders
received from the delivery
platform.

otNum number Object number for Order Type
to be used for orders received
from the delivery platform.

remakeOtNum number Set to -1 because the object is
not valid for Rappi. Do not
change this value.
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Table 4-3    (Cont.) Delivery Platform Configuration

Name Type Description

tendNum number Object number for Tender
Media to be used to settle
orders received from the
delivery platform.

priceSequences string
number

Type of base menu item and
condiment (optional).
Number is the price level.

condimentGroupRuleFilter number
true/false

Numbers separated by
commas. Numbers are the
condiment groups.
True directs the application to
use the numbers listed. False
excludes the numbers listed.

itemImageSlot number Menu item image slot number
used for the product display in
the delivery platform.

sluSlot number Menu item SLU slot number
used for the product display in
the delivery platform.

discountId number Object number for Discount to
be used for open discount
promotion orders received
from the delivery platform.
The discountId is required.

countryBaseUrl string Set to the domain of the
country.
See the Rappi API
Documentation at https://dev-
portal.rappi.com/getting-started/
#country-domains for a list of
country domains.

menus DeliveryPlatformMenu[] Details for menu(s) to be
submitted to the delivery
platform.
Make sure to follow any
limitations imposed by the
delivery platform on the
number of menus.

Table 4-4    Delivery Platform Menu

Name Type Description

name TranslatedString Display name for menu by
locale.

identifier string Identifier for menu to be used
in tags.
Make sure the identifier does
not conflict with tags used for
other purposes.
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Table 4-4    (Cont.) Delivery Platform Menu

Name Type Description

imageURL string URL for image associated with
menu.
Upload the menu image to the
Oracle Object Store through a
dummy menu item.

Activating the Delivery Service Provider Interface

WARNING:

Ensure that all configuration has been completed before activating the delivery
platform.

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Interfaces tab, and then select Delivery Platform Integrations.

3. In the Delivery Platform Integrations section, select the delivery platform to enable it.

If you no longer use a delivery platform, disable it.

4. Click Save.

One hour after activation of the Delivery Platform Integrations option, the store will be
visible and ready for ordering on the delivery service provider website.

Verifying Setup
After configuring Simphony, wait an hour and then go to the delivery service website. Verify the
following information:

1. The latest menu is synced to the website.

2. Once the menu is synced to the website, reply to the Rappi email and confirm that the
store can go live.

3. Once the store is live, place an order, and then confirm that the check is printed in the
kitchen.

Chapter 4
Activating the Delivery Service Provider Interface

4-22



5
Skip

Skip The Dishes is supported with Simphony release 19.5 and later. Review the following
checklist before you set up Simphony for Skip:

• Decide on your menu. Skip supports up to two menus.

• Decide on unique tag names for the menu or menus.

• Plan the list of menu items.

• Determine menu availability. For example, will the menu be available only on weekdays
between specific times?

• The menus can have multiple categories but must have at least one category. A category
is a group of similar menu items. For example, you can have a lunch menu with categories
for salads, sandwiches, and desserts.

In Simphony, a category corresponds to a SLU. Each category needs its own SLU.

Note:

Skip supports a maximum of 100 SLUs.

• Decide on an image to display for each menu. This is optional.

• Consider the following characteristics of each menu item:

– Customer-facing menu item name

– Customer-facing menu item description

– Menu item image that meets the following specifications:

* JPEG or PNG file format

* Pixel size of 1920 x 1080

* Aspect ratio of 16:9

Note:

All images are manually verified by Skip and will not appear immediately on
the ordering site.

– Menu item price

– Allergen classes

• Consider the display of menu items on delivery platform ordering sites and kiosks, and
determine whether advanced menu options are needed:

– Price sequence level filter

– Condiment group filter

– Image slot
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– SLU slot

Registering with Skip
1. Complete the Skip registration form, located at https://restaurants.skipthedishes.com/

application, and sign up for a merchant account.

2. Establish a store in Skip for each revenue center that will process Skip orders.

3. Advise Skip that this is an Oracle integration.

4. You will receive store IDs for each store created.

5. Complete the Simphony configuration steps detailed below.

6. You will receive a menu preview link following your first successful menu sync (as shown in
the Verifying Setup section).

7. Advise Skip that the site is ready for use, and they will perform final activation.

8. You will receive a confirmation email that your site is ready for use.

Transaction Services Generation 2
The delivery service provider integration requires Simphony Transaction Services Generation 2
(STS Gen2).

For locations that will integrate with delivery service providers, follow these steps to either
enable STS Gen2 for the first time, or confirm that it is set up correctly.

Configuring Workstations
Add a SimphonyTransaction Services Generation 2 (STS Gen2) workstation or validate that an
existing STS Gen2 workstation is configured for each location. The STS Gen2 workstation
must be a CAPS Service Host and the Type must be POS API Client.

If you have more than one POS API Client workstation type available in a revenue center,
Oracle Food and Beverage recommends enabling at least two workstation devices that can
receive checks and orders as this will provide resiliency should one of the workstations
become unavailable.

1. Log in to EMC.

2. Select the location (property), click Setup, and then click Workstations.

3. If you do not see an STS Gen2 workstation in the list that is a CAPS Service Host with
Type POS API Client, follow these steps:

a. Locate the workstation record with the Check and Posting Service (CAPS), and then
double-click the column number to the left of this workstation record to open it.

The CAPS workstation record is usually the first one listed.

b. Click the Service Host tab, and confirm that the Type value shows Check and
Posting (CAPS).

c. Select the CAPS workstation in the list in the left pane, and then click the General tab.

d. Click the insert icon
(

) on the toolbar.
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e. Enter STSCAPS in the Record Name field, and then click OK.

f. Click the General tab, and then select 3 - POS API Client from the Type drop-down
list.

g. In the General Settings section, select Enable Simphony Transaction Services (Gen
2) Cloud API.

h. Confirm that the Type value shows 3 - POS API Client.

i. In the Service Host ID field, select the Service Host that is running CAPS.

j. Click the Order Devices tab, and then enable the order devices on which online
orders will print.

k. Click the Transactions tab, and then select the Default Order Type for the
workstation.

l. Click the Revenue Centers tab, and then select the revenue center from the drop-
down list.

m. Click Save.

Configuring Revenue Center Parameters
1. Log in to EMC.

2. Select the revenue center, click Setup, and then click RVC Parameters.

3. Click the Options tab, and then enable 74 - Enable Simphony Transaction Services
Gen 2.

Figure 5-1    RVC Parameters Options

4. Click Save.

Creating Tender Media
You need to create a dedicated tender record for each delivery service provider. These tender
records are used when posting delivery service provider orders. The tenders can be set up to
process online orders.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.
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2. Insert a tender record for each food delivery order, enter the name (for example,
UberEatsAccount, PostmatesAccount, DeliverooAccount, DoorDashAccount,
GlovoAccount, RappiAccount, and so on), and then click OK.

3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click the Options tab, and then click the Ops Behavior subtab.

6. Select 3 - Assume Paid in Full.

7. Click Save.

Creating Order Types
Create an order type for each delivery service provider you do business with. See the Oracle
MICROS Simphony Configuration Guide for more information on configuring order types.
When creating the order type, keep these points in mind:

• Name the order type after the delivery service provider.

• Tax is not billed to delivery service provider orders. The delivery service provider collects
taxes from the customer. In the Order Type Parameters module, do not select any tax rates
in the Tax Masks column.

• Use a separate order type for remake orders.

While it is possible to use existing order types with each delivery service provider, configuring
an order type specifically for each delivery service provider makes it easier to track the orders
for that delivery service provider in the kitchen and on reports.

Configuring an Open Discount
Configure an open dollar discount for Skip, which is used for promotions. See Configuring
Discounts in the Oracle MICROS Simphony Configuration Guide for detailed instructions. In
the Discounts module, General tab of the EMC, name the discount after the delivery service
provider (for example, SkipDiscount), set the Condiment Discountability to 4 - Parent and
All Condiment Items, and enable the discount option 1 - ON = Open; OFF = Preset.

Configuring an Open Service Charge
Configure an open amount service charge for Skip. See Configuring Service Charges in the
Oracle MICROS Simphony Configuration Guide for detailed instructions. In the Service
Charges module, enable the Service Charge options 1 - ON = Open; OFF = Preset and 2 -
ON = Amount; OFF = Percentage.

Creating a Skip Employee
Skip orders enter Simphony using an employee configured for this purpose. Configuring a
dedicated employee record for Skip orders allows you to track these orders.

See the Oracle MICROS Simphony Configuration Guide for more information on configuring
the transaction services default employee and how to create the employee record.

After adding the employee, record the value shown in the # field of the Employee Maintenance
module. The delivery configuration in the revenue center requires the POS employee object
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number (shown in the # field) when configuring the JSON file in a later section of Skip
configuration.

Adding a Data Extension Record
1. Select the Enterprise, click Configuration, and then click Data Extensions.

Figure 5-2    EMC Enterprise Main Menu

2. Click the Insert  icon on the toolbar to add a record, enter the Data Extension record
name, and then click OK.

Figure 5-3    EMC Enterprise Main Menu

3. Enter information in the following fields:
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Table 5-1    Data Extension Fields

Field Description

Table Select 20 - Revenue Center.

Extra Column Name Enter DeliveryPlatformConfigurationData.

Type Select 12 - Json.

Data Constraints Select Max Chars: 9999.

Sort Priority Not applicable; use default value.

Display Width Enter 150.

Translatable Name Not applicable; use default value.

Translatable Help Not applicable; use default value.

Figure 5-4    Data Extension Module Fields

4. Click Save.

Configuring Currency Settings
1. Select the Enterprise, property, or zone, click Setup, and then click Currency.

2. Double-click the record for the currency used by the delivery service provider (for example,
US Dollars).

3. Enter or change the Abbreviation for the currency per the ISO 4217 currency code
standards.

See the Oracle MICROS Simphony Configuration Guide for more information on
configuring currencies.

4. Click Save.

Configuring the Language Culture
1. Select the Enterprise, click Setup, and then click Languages.
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2. Double-click the language record, and then click the Miscellaneous tab.

3. Select the Locale ID, and then enter the Language Culture corresponding to the
language.

Ensure that the Language Culture is set to the appropriate value for the language. See
the Oracle MICROS Simphony Configuration Guide for more information on configuring
languages.

4. Click Save.

Creating Allergen Classes
1. Select the Enterprise level, click Descriptors, and then click Allergen Names.

Figure 5-5    EMC Enterprise Descriptors Tab - Allergen Names

• The module has several pre-configured allergen names/codes.
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Figure 5-6    EMC Allergen Names Module

• The existing allergen names and codes cannot be edited or deleted; however the text
can be translated.

2. To insert new allergen names:
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a. Click the insert icon

on the toolbar.

b. After adding a record, click OK, and then click Save.

The system does not allow duplicate allergen names.

Figure 5-7    Inserting Allergen Names

3. Select the Enterprise level, click Configuration, and then click Allergen Classes.
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Figure 5-8    EMC Configuration Tab - Allergen Classes

4. Insert a new record and enter a name for the allergen class.

You can configure the Allergen Classes module from either table or form view. In table
view, if more than one allergen is selected, allergens are listed and comma separated.

Figure 5-9    Allergen Classes - Table View

5. Based on the allergy class’ name, select the allergen you want to include in the class.

You can select more than one allergen. Switch to form view by using the toggle icon on the
toolbar

, or double-click the record.

This is an example of an allergen class named Seafood. Each allergen selected here is
seafood related.
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Figure 5-10    Allergen Classes - Form View

6. Create as many allergen classes as needed, and then click Save.

7. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

8. On the General tab, assign an allergen class from the drop-down list in the Allergen
Class field, and then click Save.
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Figure 5-11    Menu Item Classes - Allergen Class Field

9. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

10. Search Menu Item Definition records for items you wish to assign an allergen class.

11. On the record’s General tab, select the allergen class from the drop-down list that you
want to assign to the menu item class from the Allergen Class Override field, click OK,
and then click Save.
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Figure 5-12    Menu Item Definition - Allergen Class Override Field

Creating Menu Tags
A delivery service provider menu is a collection of Simphony menu items. Use a menu tag to
associate a Simphony menu item with the delivery provider menu. Each provider must have a
unique menu tag in Simphony. Only the menu items with these tags are visible in the delivery
provider application.

You need to have the role privilege to view, edit, add, or delete tags. See the Oracle MICROS
Simphony Configuration Guide for more information on creating roles and setting privileges for
tags in the Roles module, EMC Modules tab.

Simphony retains all tag activity (including add, edit, and delete) for use in auditing.

1. To create a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Click the insert icon
(

) on the toolbar.

c. Add a new tag record with the appropriate name (for example, Online Only), and then
click OK.

You cannot duplicate tag names.

d. Click Save.

2. To edit a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Change the tag name in the Name column.
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c. Click Save.

3. To delete a tag:

If you delete a tag that is associated with a menu item definition, the association is also
deleted.

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Highlight the tag record, click the delete icon
(

) on the toolbar, and then click Yes.

c. Click Save.

4. To associate a tag with a menu item definition, see the Oracle MICROS Simphony
Configuration Guide for instructions.

Creating Screen Look Ups for Menu Items
You can assign each menu item definition to a maximum of eight different SLUs in table view of
the Menu Item Maintenance module. Assigning multiple SLUs to a menu item allows flexibility
in building POS client pages that are customized to use dine in, carry out, and curbside to go,
and shows the menu items supported by the order type.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click
Menu Item.

2. Insert a new record, enter a name for the menu item screen look up (for example,
DinnerCarryOut) in the Record Name field, and then click OK.

3. Repeat step 2 to add more SLUs, and then click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

5. To assign a SLU, click the ellipsis point (...) button adjacent to the menu item First Name,
select the SLU, and then click OK.

To assign another SLU to the menu item, select the SLU from the SLU 2 column. You can
assign up to eight SLUs per menu item. Duplicate SLUs do not appear on the same
workstation page.

6. (Optional) To assign a SLU sort priority:

a. Double-click a menu item, and then click General.

b. Select the relevant SLU from the Touchscreen Properties section.

Use the SLU 2, SLU 3, and so on for multiple SLUs.

c. Enter a SLU Sort Priority (between 1-99) for the menu item.

Use this field when Page Design Layout option, Use Sort Priority, is enabled from the
Screen Lookup settings.

When SLU Sort Priority is used, menu items with Sort Priority 1 appear on the screen
first, followed by menu items with Sort priority 2, and so on up to Sort Priority 99, and
then finally Sort Priority 0 items. (Priority 0 means “Do not sort”; items with 0 appear at
the end of the list.) Typically the most popular menu items have Sort Priority 1 for easy
access. Items in the same SLU can belong to the same Sort Priority.
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Figure 5-13    Page Design Screen Lookup (SLU) Layout Settings

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Menu Item from the Type drop-down list, select SLU as the Property, and then
select the menu item screen lookup as the Value.

11. Select the Menu Item Display Name, and then click Save.

12. If the revenue center uses hand held POS client devices:

a. Select Dynamic SLU as the Property, and then select a menu item screen look up
group as the SLU Value.

b. Enter a non-zero value for the Visual State(s).

The application uses the Visual State value to link menu item screen look ups with
their corresponding Visual State buttons, which workstation operators use to change
the menu items that appear in the Dynamic SLU.
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c. To add more screen look ups to the Dynamic SLU, click Add.

d. Select the Menu Item Display Name, and then click Save.

e. Insert buttons for each screen look up that you added to the Dynamic SLU.

For example, if you added five screen look up groups to the Dynamic SLU, insert five
buttons.

f. Select Function from the Type drop-down list, and then select Visual State from the
Function list.

g. In the Arguments field, enter the Visual State value that you assigned to a screen
look up group in Step 12-b.

h. Click Save.

Configuring Menu Items
Delivery service provider integrations do not support combo meals or conversational ordering.

After creating menu items, add condiments to the items that need them, and then follow these
steps:

1. If necessary, update the menu tag as described in Creating Menu Tags.

2. Update and assign the SLU to the menu item as described in Assigning a SLU.

3. If necessary, update the menu item prices as described in Setting Menu Item Prices.

4. Specify the menu item name, item description, and image the customer sees when
ordering through the delivery application. See Configuring Customer-Facing Content for
more information.

5. If necessary, update the allergen class as described in Assigning Allergy Information for a
Menu Item.

6. Change the availability status of a menu item to generate a notification through the delivery
application, advising Skip of the menu item’s new status (unavailable or available). These
updates are immediately sent to Skip and will update in near real time.

Assigning a SLU

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then double-click the menu item in the list.

3. Click the General subtab.

4. In the Touchscreen Properties section, select the relevant SLU from the drop-down lists in
SLU through SLU 8.

You can assign up to eight SLUs per menu item. The SLU number specifies the order in
which SLUs appear on the delivery provider ordering site (from least to greatest number).
For example, a menu item assigned to SLU 2 will appear in the Entrees category:

1 Starters

2 Entrees

3 Desserts

5. Click Save.
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Setting Menu Item Prices

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Prices subtab.

4. Set the menu item price in the Price column.

If the menu item has multiple prices associated with different menu levels, ensure that
each level has an appropriate prefix configured. See the Oracle MICROS Simphony
Configuration Guide for information on setting main, sub, and custom menu levels.

5. Click Save.

Configuring Customer-Facing Content

Specify the menu item name, description, and image that customers see in the delivery
provider application when placing an order.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Images subtab.

4. Enter or change the Consumer Item Name.

5. Enter or change the Consumer Item Description.

6. In the Image 1 section, click Upload to select the image and upload it to Simphony.

7. (Optional) Enter or change the image Title.

8. (Optional) Enter or change the image Comments.

9. Enter the URL that links to the image.

10. Click Save.

Assigning Allergy Information for a Menu Item
When using Skip, you have the option to include allergen information for a menu item on the
delivery service provider application.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the General subtab.

4. In the Allergen Class Override field, click Select, select the allergen class, and then click
OK.

5. Click Save.
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Configuring Advanced Menu Item Options
When considering the display of menu items on delivery platform ordering sites and kiosks,
additional menu item options are available. The modifiers and prices used in Simphony POS
Operations may not be the same as those displayed to delivery platform customers on online
ordering sites or kiosks.

You can create additional menu item definitions (see Configuring Menu Item Definitions in the
Oracle MICROS Simphony Configuration Guide), or set Delivery Connector advanced menu
item configurations options. These advanced options are controlled in revenue centers and in
JSON code, and are as follows for Skip:

Price Sequence Level Filter
The price sequence filter lets you specify the menu item price sequence levels used in the
delivery service provider. You can apply the price sequence filter to base menu items (for
example, a hamburger) and to condiments (for example, cheese). This filter affects all menu
items that are passed to the delivery service provider.

See Sample JSON: Skip for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

Condiment Group Filter
The condiment group filter lets you specify the condiment groups for each delivery service
provider. The filter allows the condiment groups in the Menu Item Classes module to be
included or excluded. This prevents unwanted condiments and condiment groups from being
displayed on the delivery service provider ordering site.

To specify the condiment group filter in the JSON code, set condiment group numbers
separated by commas, and true or false to indicate whether the condiment group specified
will be included or excluded from the delivery service provider.

See Sample JSON: Skip for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

Image Slot
If multiple image slots are in use for an organization, the item image slot lets you specify which
menu item image slot is used for the product display in the delivery service provider, rather
than the default setting of 1. This feature is used with kiosks and online ordering sites.

See Sample JSON: Skip for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

SLU Slot
The Screen Look Up (SLU) slot lets you specify which SLU slot is used for the product display
in delivery service providers. By default, the system shows all SLUs assigned to a menu item
as categories in the delivery service provider. If multiple SLUs are in use for an organization,
the SLU slots appear as multiple categories with the source product displayed in each SLU.
The selection allows customers to specify the SLU name to use as a category name in their
delivery service provider.
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See Sample JSON: Skip for a description of JSON data values and a code sample that you
can copy and change for your restaurant.

Creating Delivery Configuration in the Revenue Center
Configuration for delivery service provider platform integrations is specified in EMC through the
Data Extensions column named DeliveryPlatformConfigurationData, which is added to the
revenue center table, populated with the JSON representation of the data structure.

1. Select the property, click Setup, and then click RVC Configuration.

2. Double-click the revenue center, and then click the Data Extensions tab.

3. In the Column field, locate DeliveryPlatformConfigurationData, and then click Edit
Json.

4. Enter JSON configuration data and then click OK.

See Sample JSON: Skip for descriptions of JSON data values and code samples that you
can copy and change for your restaurant. After you change the sample values, you can
copy your restaurant code into the DeliveryPlatformConfigurationData column to
complete this step.

5. Click Save.

Sample JSON: Skip

The following sample shows JSON code for Skip. The tables that follow the code sample
describe the values in the code.

Tip:

Click Copy to copy the code to your clipboard and then paste it into a text editor such
as Notepad++. Change the values for your restaurant and then copy your code into
the DeliveryPlatformConfigurationData column as described in Creating Delivery
Configuration in the Revenue Center.

{
    "deliveryPlatformConfigurations": [
         {
            "name": "Skip",
            "groupIdentifier": "",
            "rvcIdentifier": "aaf2b581-b5f0-42e2-928c-351c55a35a57",
            "empNum": 2,
            "otNum": 1,
            "tendNum": 150,
            "priceSequences": 
                [
                {
                "type": "BaseItem",
                "levels": [2]
                },
                {
                "type": "Condiment",
                "levels": [6, 7, 8]
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                }
                ]
            "condimentGroupRuleFilter": 
                {
                "values": "1,2,3,4",
                "include": true
                }
            "itemImageSlot": 2
            "sluSlot": 1
                  "discountId": 1,
                  "serviceChargeId": 1  
            "menus": [{
                        "name": {
                                "en-US": "Delivery"
                    },
                    "identifier": "SkipDelivery",
                    "type": "DELIVERY",
                    "availability": [{
                                "dayOfWeek": "Mon",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                                "dayOfWeek": "Tue",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                                "dayOfWeek": "Wed",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Thu",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Fri",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sat",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sun",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                ]
        },
{
                        "name": {
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                                "en-US": "Skip Pickup"
                    },
                    "identifier": "SkipPickup",
                    "type": "COLLECTION",
                    "availability": [{
                                "dayOfWeek": "Mon",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                                "dayOfWeek": "Tue",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                                "dayOfWeek": "Wed",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Thu",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Fri",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sat",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                        {
                            "dayOfWeek": "Sun",
                                "startTime": "00:00",
                                "endTime": "23:59"
                        },
                ]
            }
        ]
}

Table 5-2    Data Extensions Column Name

Name Type Description

deliveryPlatformConfiguration
s

DeliveryPlatformConfiguratio
n[]

Revenue center’s integration
configuration for each
applicable delivery platform.
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Table 5-3    Delivery Platform Configuration

Name Type Description

name string Skip
Do not change this value.

groupIdentifier string Set to null because the object
does not apply to Skip.

rvcIdentifier string Identifier for the revenue
center. This is the Site ID
obtained during the
registration process.

empNum number Object number for employee to
be used to enter orders
received from the delivery
platform.

otNum number Object number for Order Type
to be used for orders received
from the delivery platform.

remakeOtNum number Set to -1 because the object is
not valid for Skip. Do not
change this value.

tendNum number Object number for Tender
Media to be used to settle
orders received from the
delivery platform.

priceSequences string
number

Type of base menu item and
condiment (optional).
Number is the price level.

condimentGroupRuleFilter number
true/false

Numbers separated by
commas. Numbers are the
condiment groups.
True directs the application to
use the numbers listed. False
excludes the numbers listed.

itemImageSlot number Menu item image slot number
used for the product display in
the delivery platform.

sluSlot number Menu item SLU slot number
used for the product display in
the delivery platform.

discountId number Object number for Discount to
be used for open discount
promotion orders received
from the delivery platform.
The discountId is required.

serviceChargeId number Object number for Service
Charge to be used for orders
received from the delivery
platform.
The serviceChargeId is
required.
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Table 5-3    (Cont.) Delivery Platform Configuration

Name Type Description

menus DeliveryPlatformMenu[] Details for menu(s) to be
submitted to the delivery
platform.
Make sure to follow any
limitations imposed by the
delivery platform on the
number of menus.

Table 5-4    Delivery Platform Menu

Name Type Description

name TranslatedString Display name for menu by
locale.

identifier string Identifier for menu to be used
in tags.
Make sure the identifier does
not conflict with tags used for
other purposes.

type string The Types are DELIVERY and
COLLECTION. Do not change
these values.
Each type has a single menu.
Skip uses these two types to
determine the Skip internal
order type for the order.

Activating the Delivery Service Provider Interface

WARNING:

Ensure that all configuration has been completed before activating the delivery
platform.

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Interfaces tab, and then select Delivery Platform Integrations.

3. In the Delivery Platform Integrations section, select the delivery platform to enable it.

If you no longer use a delivery platform, disable it.

4. Click Save.

One hour after activation of the Delivery Platform Integrations option, the store will be
visible and ready for ordering on the delivery service provider website.
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Verifying Setup
After configuring Simphony, wait an hour and then go to the delivery service website. Verify the
following information:

1. The latest menu is synced to the website.

2. Once the menu is synced to the website, reply to the Glovo email and confirm that the
store can go live.

3. Once the store is live, place an order, and then confirm that the check is printed in the
kitchen.
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6
Uber Eats/Postmates

Uber Eats/Postmates is supported with Simphony release 19.2.1 and later.

Postmates accounts can be used interchangeably with Uber Eats accounts to activate stores.
You can use your Postmates login to integrate stores with Simphony.

Review the following checklist before you set up Simphony for Uber Eats/Postmates:

• Decide on your menus. Uber Eats supports multiple menus.

• Decide on unique tag names for each menu.

• Plan the list of menu items. A menu item can be part of multiple menus.

• Determine the availability for each menu. For example, is one menu available for part of
the day and another menu is available for another part of the same day?

• The menu can have multiple categories but must have at least one category. A category is
a group of similar menu items. For example, you can have a lunch menu with categories
for salads, sandwiches, and desserts.

In Simphony, a category corresponds to a SLU. Each category needs its own SLU.

• Decide on an image to display for the menu. This is optional.

• Consider the following characteristics of each menu item:

– Customer-facing menu item name

– Customer-facing menu item description

– Menu item image that meets the following specifications:

* JPEG or PNG file format

* JPEG file size less than 1 MB

* JPEG width and height minimum of 320px and a maximum of 1800px

* PNG width and height minimum of 350px and a maximum of 1800px

– Menu item price

– Nutrient information

• Consider the display of menu items on delivery platform ordering sites and kiosks, and
determine whether advanced menu options are needed:

– Price sequence level filter

– Condiment group filter

– Image slot

– SLU slot

– Default condiments

– KDS notification
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Registering with Uber Eats
1. Sign up for Uber Eats at https://merchants.ubereats.com/us/en/s/signup/.

2. Establish a store in Uber Eats for each revenue center that will process Uber Eats orders.

Enabling Locations
The Delivery Connectors UI allows activation and deactivation of a store’s Delivery Provider
integration. The Delivery Adapter UI supports Uber Eats integration.

1. Select the revenue center, click Setup, and then click RVC Paramters.

2. Click the Interfaces tab.

3. In the Delivery Platform Integrations area, click the Launch Provisioning Portal button. A
browser window opens and loads the Provisioning Portal.

Do not bookmark the URL; access this only through the EMC.

4. Log in to the Uber Eats provider with your credentials for Uber Eats or Postmates. A list of
stores that are eligible for provisioning appears.

5. Select one or more stores using the check box, and then click the Enable button.

Copy the associated store ID(s) for use later in the Creating the Delivery Configuration in
the Revenue Center section of this document.

6. Close the browser and continue the configuration process.

Transaction Services Generation 2
The delivery service provider integration requires Simphony Transaction Services Generation 2
(STS Gen2).

For locations that will integrate with delivery service providers, follow these steps to either
enable STS Gen2 for the first time, or confirm that it is set up correctly.

Configuring Workstations
Add a SimphonyTransaction Services Generation 2 (STS Gen2) workstation or validate that an
existing STS Gen2 workstation is configured for each location. The STS Gen2 workstation
must be a CAPS Service Host and the Type must be POS API Client.

If you have more than one POS API Client workstation type available in a revenue center,
Oracle Food and Beverage recommends enabling at least two workstation devices that can
receive checks and orders as this will provide resiliency should one of the workstations
become unavailable.

1. Log in to EMC.

2. Select the location (property), click Setup, and then click Workstations.

3. If you do not see an STS Gen2 workstation in the list that is a CAPS Service Host with
Type POS API Client, follow these steps:

a. Locate the workstation record with the Check and Posting Service (CAPS), and then
double-click the column number to the left of this workstation record to open it.

The CAPS workstation record is usually the first one listed.
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b. Click the Service Host tab, and confirm that the Type value shows Check and
Posting (CAPS).

c. Select the CAPS workstation in the list in the left pane, and then click the General tab.

d. Click the insert icon
(

) on the toolbar.

e. Enter STSCAPS in the Record Name field, and then click OK.

f. Click the General tab, and then select 3 - POS API Client from the Type drop-down
list.

g. In the General Settings section, select Enable Simphony Transaction Services (Gen
2) Cloud API.

h. Confirm that the Type value shows 3 - POS API Client.

i. In the Service Host ID field, select the Service Host that is running CAPS.

j. Click the Order Devices tab, and then enable the order devices on which online
orders will print.

k. Click the Transactions tab, and then select the Default Order Type for the
workstation.

l. Click the Revenue Centers tab, and then select the revenue center from the drop-
down list.

m. Click Save.

Configuring Revenue Center Parameters
1. Log in to EMC.

2. Select the revenue center, click Setup, and then click RVC Parameters.

3. Click the Options tab, and then enable 74 - Enable Simphony Transaction Services
Gen 2.

Figure 6-1    RVC Parameters Options

4. Click Save.
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Creating Tender Media
You need to create a dedicated tender record for each delivery service provider. These tender
records are used when posting delivery service provider orders. The tenders can be set up to
process online orders.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a tender record for each food delivery order, enter the name (for example,
UberEatsAccount, PostmatesAccount, DeliverooAccount, DoorDashAccount,
GlovoAccount, RappiAccount, and so on), and then click OK.

3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click the Options tab, and then click the Ops Behavior subtab.

6. Select 3 - Assume Paid in Full.

7. Click Save.

Creating Order Types
Create an order type for each delivery service provider you do business with. See the Oracle
MICROS Simphony Configuration Guide for more information on configuring order types.
When creating the order type, keep these points in mind:

• Name the order type after the delivery service provider.

• Tax is not billed to delivery service provider orders. The delivery service provider collects
taxes from the customer. In the Order Type Parameters module, do not select any tax rates
in the Tax Masks column.

• Use a separate order type for remake orders.

While it is possible to use existing order types with each delivery service provider, configuring
an order type specifically for each delivery service provider makes it easier to track the orders
for that delivery service provider in the kitchen and on reports.

Creating an Uber Eats/Postmates Employee
Uber Eats orders enter Simphony using an employee configured for this purpose. Configuring
a dedicated employee record for Uber Eats or Postmates orders allows you to track these
orders.

See the Oracle MICROS Simphony Configuration Guide for more information on configuring
the transaction services default employee and how to create the employee record.

After adding the employee, record the value shown in the # field of the Employee Maintenance
module. The delivery configuration in the revenue center requires the POS employee object
number (shown in the # field) when configuring the JSON file in a later section of Uber Eats
configuration.

Adding a Data Extension Record
1. Select the Enterprise, click Configuration, and then click Data Extensions.
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Figure 6-2    EMC Enterprise Main Menu

2. Click the Insert  icon on the toolbar to add a record, enter the Data Extension record
name, and then click OK.

Figure 6-3    EMC Enterprise Main Menu

3. Enter information in the following fields:

Table 6-1    Data Extension Fields

Field Description

Table Select 20 - Revenue Center.

Extra Column Name Enter DeliveryPlatformConfigurationData.

Type Select 12 - Json.
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Table 6-1    (Cont.) Data Extension Fields

Field Description

Data Constraints Select Max Chars: 9999.

Sort Priority Not applicable; use default value.

Display Width Enter 150.

Translatable Name Not applicable; use default value.

Translatable Help Not applicable; use default value.

Figure 6-4    Data Extension Module Fields

4. Click Save.

Configuring Currency Settings
1. Select the Enterprise, property, or zone, click Setup, and then click Currency.

2. Double-click the record for the currency used by the delivery service provider (for example,
US Dollars).

3. Enter or change the Abbreviation for the currency per the ISO 4217 currency code
standards.

See the Oracle MICROS Simphony Configuration Guide for more information on
configuring currencies.

4. Click Save.

Configuring the Language Culture
1. Select the Enterprise, click Setup, and then click Languages.

2. Double-click the language record, and then click the Miscellaneous tab.

3. Select the Locale ID, and then enter the Language Culture corresponding to the
language.
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Ensure that the Language Culture is set to the appropriate value for the language. See
the Oracle MICROS Simphony Configuration Guide for more information on configuring
languages.

4. Click Save.

Creating Menu Tags
A delivery service provider menu is a collection of Simphony menu items. Use a menu tag to
associate a Simphony menu item with the delivery provider menu. Each provider must have a
unique menu tag in Simphony. Only the menu items with these tags are visible in the delivery
provider application.

You need to have the role privilege to view, edit, add, or delete tags. See the Oracle MICROS
Simphony Configuration Guide for more information on creating roles and setting privileges for
tags in the Roles module, EMC Modules tab.

Simphony retains all tag activity (including add, edit, and delete) for use in auditing.

1. To create a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Click the insert icon
(

) on the toolbar.

c. Add a new tag record with the appropriate name (for example, Online Only), and then
click OK.

You cannot duplicate tag names.

d. Click Save.

2. To edit a tag:

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Change the tag name in the Name column.

c. Click Save.

3. To delete a tag:

If you delete a tag that is associated with a menu item definition, the association is also
deleted.

a. Select the Enterprise, click Descriptors, and then click Tags.

b. Highlight the tag record, click the delete icon
(

) on the toolbar, and then click Yes.

c. Click Save.

4. To associate a tag with a menu item definition, see the Oracle MICROS Simphony
Configuration Guide for instructions.
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Creating Screen Look Ups for Menu Items
You can assign each menu item definition to a maximum of eight different SLUs in table view of
the Menu Item Maintenance module. Assigning multiple SLUs to a menu item allows flexibility
in building POS client pages that are customized to use dine in, carry out, and curbside to go,
and shows the menu items supported by the order type.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click
Menu Item.

2. Insert a new record, enter a name for the menu item screen look up (for example,
DinnerCarryOut) in the Record Name field, and then click OK.

3. Repeat step 2 to add more SLUs, and then click Save.

4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Menu Item Maintenance.

5. To assign a SLU, click the ellipsis point (...) button adjacent to the menu item First Name,
select the SLU, and then click OK.

To assign another SLU to the menu item, select the SLU from the SLU 2 column. You can
assign up to eight SLUs per menu item. Duplicate SLUs do not appear on the same
workstation page.

6. (Optional) To assign a SLU sort priority:

a. Double-click a menu item, and then click General.

b. Select the relevant SLU from the Touchscreen Properties section.

Use the SLU 2, SLU 3, and so on for multiple SLUs.

c. Enter a SLU Sort Priority (between 1-99) for the menu item.

Use this field when Page Design Layout option, Use Sort Priority, is enabled from the
Screen Lookup settings.

When SLU Sort Priority is used, menu items with Sort Priority 1 appear on the screen
first, followed by menu items with Sort priority 2, and so on up to Sort Priority 99, and
then finally Sort Priority 0 items. (Priority 0 means “Do not sort”; items with 0 appear at
the end of the list.) Typically the most popular menu items have Sort Priority 1 for easy
access. Items in the same SLU can belong to the same Sort Priority.
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Figure 6-5    Page Design Screen Lookup (SLU) Layout Settings

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then
click Page Design.

8. Double-click the transaction page on which you want the screen look up to appear on the
workstation.

9. Click Other in the Page Design toolbar, and then click Sales SLU.

10. Select Menu Item from the Type drop-down list, select SLU as the Property, and then
select the menu item screen lookup as the Value.

11. Select the Menu Item Display Name, and then click Save.

12. If the revenue center uses hand held POS client devices:

a. Select Dynamic SLU as the Property, and then select a menu item screen look up
group as the SLU Value.

b. Enter a non-zero value for the Visual State(s).

The application uses the Visual State value to link menu item screen look ups with
their corresponding Visual State buttons, which workstation operators use to change
the menu items that appear in the Dynamic SLU.
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c. To add more screen look ups to the Dynamic SLU, click Add.

d. Select the Menu Item Display Name, and then click Save.

e. Insert buttons for each screen look up that you added to the Dynamic SLU.

For example, if you added five screen look up groups to the Dynamic SLU, insert five
buttons.

f. Select Function from the Type drop-down list, and then select Visual State from the
Function list.

g. In the Arguments field, enter the Visual State value that you assigned to a screen
look up group in Step 12-b.

h. Click Save.

Configuring Nutrition Settings

Note:

Although the EMC shows a pre-configured list of nutrient records, you can only
specify calorie information for Uber Eats.

To configure nutritional information for menu items:

1. Select the Enterprise level, click Descriptors, and then click Nutrition Names.

Figure 6-6    EMC Enterprise Descriptors Tab - Nutrition Names

The EMC shows pre-configured nutrient records. No new nutrient records can be added at
this time. These existing nutrient names cannot be edited or deleted, but you can translate
the nutrient names in the Text column.
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Figure 6-7    EMC Nutrition Names Module

2. Select the Enterprise level, click Configuration, and then click Nutrient Sets.

Figure 6-8    EMC Configuration Tab - Nutrient Sets
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3. To insert new nutrient set records, click the insert icon

on the toolbar.

Figure 6-9    Nutrient Sets - Table View

4. Enter the nutrient set name in the Name field.

5. Switch to form view by clicking the toggle icon on the toolbar

, or double-click the record.

6. In the Nutrients section, click Add to insert and configure nutritional information.

Figure 6-10    Nutrient Sets - Adding Nutrients

7. In the Nutrient column, click the ellipsis (…), select the nutrient type from the drop-down
list, and then click OK. Repeat this step for each nutrient you add to the record.
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Figure 6-11    Adding Items to Nutrient Sets

8. In the Unit of Measure column, select the appropriate measurable for each nutrient. The
available units are:

• Calories

• Kilojoules

• Grams

• Milligrams

Figure 6-12    Nutrient Sets - Unit Of Measure Column

9. In the Quantity column, enter the numerical value associated with each unit of measure
type, and then click Save.

10. Select the Enterprise, property, or revenue center level, click Configuration, and then click
Menu Item Maintenance.

11. Search Menu Item Definition records for items you wish to assign nutrition sets.

12. (Optional) Open a menu item definition record and enter text in the Consumer Advisory
Description text box. There is a character limit of 1,024 for this field.
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Consumer advisory information typically includes disclosures about increased risk of
foodborne illness from certain foods (for example, Contains nuts or shellfish).

13. Open a menu item definition record, and then click the Nutrition tab.

14. In the Nutrients section, click the Add link.

Figure 6-13    Menu Item Definition Record - Nutrition Tab

15. In the Nutrient Set column, click the ellipsis (…), select the nutrient set from the drop-
down list, and then click OK.

Figure 6-14    Adding Nutrient Sets to a Menu Item Definition Record

16. You can add more than one nutrient set to a menu item definition record. Repeat these
steps for each menu item definition record for which you want to add nutrient sets.

Adding Nutrient Sets to menu item definition records cannot be performed from table view.
You need to manually add each Nutrient Set to each individual menu item definition record.

17. Click Save.

Configuring Menu Items
Delivery service provider integrations do not support combo meals or conversational ordering.
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After creating menu items, add condiments to the items that need them, and then follow these
steps:

1. Update the menu tag as described in Creating Menu Tags.

2. Update and assign the SLU to the menu item as described in Assigning a SLU.

3. If necessary, update the menu item prices as described in Setting Menu Item Prices.

4. Specify the menu item name, item description, and image the customer sees when
ordering through the delivery application as described in Configuring Customer-Facing
Content.

5. Add nutrient information as described in Adding a Nutrient Set.

6. Change the availability status of a menu item to generate a notification through the delivery
application, advising Uber Eats of the menu item’s new status (unavailable or available).
These updates are immediately sent to Uber Eats and will update in near real time.

Assigning a SLU

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then double-click the menu item in the list.

3. Click the General subtab.

4. In the Touchscreen Properties section, select the relevant SLU from the drop-down lists in
SLU through SLU 8.

You can assign up to eight SLUs per menu item. The SLU number specifies the order in
which SLUs appear on the delivery provider ordering site (from least to greatest number).
For example, a menu item assigned to SLU 2 will appear in the Entrees category:

1 Starters

2 Entrees

3 Desserts

5. Click Save.

Setting Menu Item Prices

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Prices subtab.

4. Set the menu item price in the Price column.

If the menu item has multiple prices associated with different menu levels, ensure that
each level has an appropriate prefix configured. See the Oracle MICROS Simphony
Configuration Guide for information on setting main, sub, and custom menu levels.

5. Click Save.
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Configuring Customer-Facing Content
Specify the menu item name and description that customers see in the delivery provider
application when placing an order.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Images subtab.

4. Enter or change the Consumer Item Name.

5. Enter or change the Consumer Item Description.

6. In the Image 1 section, click Upload to select the image and upload it to Simphony.

7. (Optional) Enter or change the image Title.

8. (Optional) Enter or change the image Comments.

9. Enter null in the URL field.

Uber Eats does not support a menu image.

10. Click Save.

Adding a Nutrient Set
When using Uber Eats/Postmates, you have the option to add a Nutrient Set for a menu item.
Only the Calories nutrient type with either Calories or KiloJoules units are supported.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search in the master records, and then select the menu item from the list.

3. Click the Nutrition subtab.

4. Click Add.

5. In the Nutrient Set column, click the ellipsis (…), select the Calorie nutrient from the drop-
down list, and then click OK.

6. Click Save.

Configuring Combo Meals
Simple combo meals are supported with Uber Eats/Postmates; sized combo meals are not
supported with delivery service providers. Complete the Simphony combo meal configuration
described in Combo and Fixed Price Meals in the Oracle MICROS Simphony Configuration
Guide, but do not configure sized combo meals.

The following configuration is required to synchronize combo meals from Simphony to delivery
providers through delivery connectors:

1. Create Combo Meal Groups.

If condiment items (not parents) are included as part of a combo group, these items are
ignored during the menu synchronization.

See Creating Combo Meal Groups in the Oracle MICROS Simphony Configuration Guide
for more information.
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2. Tag the corresponding Menu Item Master.

To include a combo in the synchronization process, the corresponding Menu Item Master
must be tagged. Items within a combo group do not need individual tags. However, if items
within a combo group are tagged individually, they appear on the delivery service provider
UI as both part of the combo and as individual à la carte items.

See Configuring Menu Tag Groups and Tags in the Oracle MICROS Simphony
Configuration Guide for more information.

Review and understand the following considerations before attempting to synchronize combos
with the delivery service provider. Ensure that your combo meal configurations adhere to these
guidelines to ensure a smooth and accurate synchronization process.

Table 6-2    Combo Meal Setup Guidelines

Simphony Considerations Description for use with Delivery Connectors

3 - Is Sized Combo Meal option If selected, and the combo meal contains
configuration consistent with sized combos, it is
ignored by the synchronization.
If a combo meal is configured as sized but does
not contain items with size specifications, it is
treated as unsized and included in the
synchronization.
See Creating Combo Meals.

Combo Group Items with Sizes in Unsized
Combos

If a combo group item has a size specification
within an unsized combo meal, it appears on
the delivery service provider UI but is treated
as unsized.
See Creating Combo Meal Groups.

Prices You can set prices for combo meals at the Menu
Item Master level, by combo group, or by
combo group item. It is recommended to set
base prices for combo meals at the Menu Item
Master level. Prices set directly on the combo
item definition are ignored. Ensure that prices
are defined for all items within a combo group
to avoid default prices of $0.00.
If the Price is not specified, Active On Level 1
is used by default.
See Combo Meal Group Pricing and Creating
Combo Meal Groups.

Alternate Groups Combo group items cannot be members of
Alternate Groups; Alternate Groups are not
supported with delivery service provider
combos.
See Creating Combo Meal Groups.
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Table 6-2    (Cont.) Combo Meal Setup Guidelines

Simphony Considerations Description for use with Delivery Connectors

Side Count and Quantity The side count for combo groups can be
configured and is controlled in the side count
area of the Combo Group. The default count is
1.

The quantity of items within a combo group,
including modifiers or weighed items, is
controlled in the Combo Group Item area. Uber
Eats supports quantities greater than 1.

See Creating Combo Meal Groups.

Combo Meal Groups Based on Menu Item
Definition

Only Menu Item Definition 1 is supported for
combos.

Invalid Items in Combo Groups If a combo meal group does not contain valid
items, it is unable to be ordered. Invalid items
include condiments and items without
definitions.

Condiment Parent as Menu Item Master If a condiment parent is configured as a Menu
Item Master, its condiment groups are ignored,
and it is treated as a regular menu item.

Duplicate Combo Meal Groups If a combo meal group is referenced multiple
times in a combo meal, the duplicates are
ignored, and only one instance of the group is
considered.

Configuring Advanced Menu Item Options
When considering the display of menu items on delivery platform ordering sites and kiosks,
additional menu item options are available. The modifiers and prices used in Simphony POS
Operations may not be the same as those displayed to delivery platform customers on online
ordering sites or kiosks.

You can create additional menu item definitions (see Configuring Menu Item Definitions in the
Oracle MICROS Simphony Configuration Guide), or set Delivery Connector advanced menu
item configurations options. These advanced options are controlled in revenue centers and in
JSON code, and are as follows for Uber Eats:

Price Sequence Level Filter
The price sequence filter lets you specify the menu item price sequence levels used in the
delivery service provider. You can apply the price sequence filter to base menu items (for
example, a hamburger) and to condiments (for example, cheese). This filter affects all menu
items that are passed to the delivery service provider.

See Sample JSON: Uber Eats for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

Condiment Group Filter
The condiment group filter lets you specify the condiment groups for each delivery service
provider. The filter allows the condiment groups in the Menu Item Classes module to be
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included or excluded. This prevents unwanted condiments and condiment groups from being
displayed on the delivery service provider ordering site.

To specify the condiment group filter in the JSON code, set condiment group numbers
separated by commas, and true or false to indicate whether the condiment group specified
will be included or excluded from the delivery service provider.

See Sample JSON: Uber Eats for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

Image Slot
If multiple image slots are in use for an organization, the item image slot lets you specify which
menu item image slot is used for the product display in the delivery service provider, rather
than the default setting of 1. This feature is used with kiosks and online ordering sites.

See Sample JSON: Uber Eats for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

SLU Slot
The Screen Look Up (SLU) slot lets you specify which SLU slot is used for the product display
in delivery service providers. By default, the system shows all SLUs assigned to a menu item
as categories in the delivery service provider. If multiple SLUs are in use for an organization,
the SLU slots appear as multiple categories with the source product displayed in each SLU.
The selection allows customers to specify the SLU name to use as a category name in their
delivery service provider.

See Sample JSON: Uber Eats for a description of JSON data values and a code sample that
you can copy and change for your restaurant.

Using Default Condiments with Uber Eats
If you have default condiments configured for a menu item in Simphony, you can pass them to
Uber Eats without having to create additional Menu Item Classes and condiment groups.

1. If the condiment group is configured as a Default Condiment master group in the Menu
Item Classes module, these condiments display as removable option in the delivery
platform.

2. If the condiment group is not configured as a Default Condiment master group in the Menu
Item Classes module, the condiments display as selected items for the menu item, and
must be disabled to remove them.

The condiment group configuration affects the way Default Condiments display on a Kitchen
Display System (KDS) and on order receipts.

• In the case of #1, a Hamburger menu item with Lettuce, Tomato, and Pickle as the Default
Condiment master group displays as Hamburger, no, Lettuce

• In the case of #2, a menu item with lettuce, tomato, and pickle as the Default Condiment
master group displays as Hamburger, Tomato, Pickle

KDS Notification
When menu items are bumped from the KDS, a notification is sent to the customer and to the
delivery driver indicating that the ordered items have been completed in the kitchen.
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Creating the Delivery Configuration in the Revenue Center
Configuration for a delivery service provider platform interface is specified in EMC through the
Data Extensions column named DeliveryPlatformConfigurationData, which is added to the
revenue center table, populated with the JSON representation of the data structure.

1. Select the property, click Setup, and then click RVC Configuration.

2. Double-click the revenue center, and then click the Data Extensions tab.

Figure 6-15    RVC Data Extensions

3. In the Column field, locate DeliveryPlatformConfigurationData, and then click Edit
Json.

4. Enter the JSON configuration data and then click OK.

See Sample JSON: Uber Eats for a description of JSON data values and a code sample
that you can copy and change for your restaurant. After you change the sample values,
you can copy your restaurant code into the DeliveryPlatformConfigurationData column
to complete this step.
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Figure 6-16    Entering JSON Code Data

5. Click Save.

Sample JSON: Uber Eats

The following sample shows JSON code for Uber Eats. The tables that follow the code sample
describe the values in the code.

Tip:

Click Copy to copy the code to your clipboard and then paste it into a text editor such
as Notepad++. Change the values for your restaurant and then copy your code into
the DeliveryPlatformConfigurationData column as described in Creating the
Delivery Configuration in the Revenue Center.

{
    "deliveryPlatformConfigurations": [
           {
            "name": "Uber Eats",
            "groupIdentifier": null,
            "rvcIdentifier": "984e0f54-64dc-15T3-e348-16942gs5arn5",
            "empNum": 990,
            "otNum": 4,
            "remakeOtNum": -1,
            "tendNum": 101,
            "priceSequences": 
                [
                {
                "type": "BaseItem",
                "levels": [2]
                },
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                {
                "type": "Condiment",
                "levels": [6, 7, 8]
                }
                ]
            "condimentGroupRuleFilter": 
                {
                "values": "1,2,3,4",
                "include": true
                }
            "itemImageSlot": 2
            "sluSlot": 1
            "menus": [{
                    "name": {
                        "en-US": "AllDayMenu"
                    },
                    "identifier": "UberEatsAllDayMenu",
                    "imageURL": null,
                    "availability": [{
                            "dayOfWeek": "Mon",
                            "startTime": "00:00",
                            "endTime": "23:00"
                        },{
                            "dayOfWeek": "Tue",
                            "startTime": "00:00",
                            "endTime": "23:00"
                        },{
                            "dayOfWeek": "Wed",
                            "startTime": "00:00",
                            "endTime": "23:00"
                        },{
                            "dayOfWeek": "Thu",
                            "startTime": "00:00",
                            "endTime": "23:00"
                        },{
                            "dayOfWeek": "Fri",
                            "startTime": "00:00",
                            "endTime": "23:00"
                        },{
                            "dayOfWeek": "Sat",
                            "startTime": "00:00",
                            "endTime": "23:00"
                        }, {
                            "dayOfWeek": "Sun",
                            "startTime": "00:00",
                            "endTime": "23:00"
                        }
                    ]
                }
            ]
        }
    ]
}

Chapter 6
Creating the Delivery Configuration in the Revenue Center

6-22



Table 6-3    Data Extensions Column Name

Name Type Description

deliveryPlatformConfiguration
s

DeliveryPlatformConfiguratio
n[]

Revenue center’s integration
configuration for each
applicable delivery platform.

Table 6-4    Delivery Platform Configuration

Name Type Description

name string Uber Eats
Do not change this value.

groupIdentifier string Set to null because the object
does not apply to Uber Eats.

rvcIdentifier string Identifier for revenue center.
This is the Site ID obtained
during the registration process.

empNum number Object number for employee to
be used to enter orders
received from the delivery
platform.

otNum number Object number for Order Type
to be used for orders received
from the delivery platform.

remakeOtNum number Set to -1 because the object is
not valid for Uber Eats. Do not
change this value.

tendNum number Object number for Tender
Media to be used to settle
orders received from the
delivery platform.

priceSequences string
number

Type of base menu item and
condiment (optional).
Number is the price level.

condimentGroupRuleFilter number
true/false

Numbers separated by
commas. Numbers are the
condiment groups.
True directs the application to
use the numbers listed. False
excludes the numbers listed.

itemImageSlot number Menu item image slot number
used for the product display in
the delivery platform.

sluSlot number Menu item SLU slot number
used for the product display in
the delivery platform.
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Table 6-4    (Cont.) Delivery Platform Configuration

Name Type Description

menus DeliveryPlatformMenu[] Details for menu(s) to be
submitted to the delivery
platform.
Make sure to follow any
limitations imposed by the
delivery platform on the
number of menus.

Table 6-5    Delivery Platform Menu

Name Type Description

name TranslatedString Display name for menu, by
locale.

identifier string Identifier for menu to be used
in tags.
Ensure that the identifier will
not conflict with tags used for
other purposes.

imageURL string Uber Eats does not support a
menu image. Set to null
because the image URL does
not apply to Uber Eats.

availability ServicePeriod[] Start and end times for each
day of the week that the menu
is to be made available.

Table 6-6    Translated String

Name Type Description

<locale code> string String translation for given
locale.

… … …

Table 6-7    Service Period

Name Type Description

dayOfWeek string First three letters of day of
week for service period.

startTime string Start time for service period, in
24-hour (hh:mm) format.

endTime string End time for service period, in
24-hour (hh:mm) format.
End time must be later than
start time.
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Activating the Delivery Service Provider Interface

WARNING:

Ensure that all configuration has been completed before activating the delivery
platform.

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Interfaces tab, and then select Delivery Platform Integrations.

3. In the Delivery Platform Integrations section, select the delivery platform to enable it.

If you no longer use a delivery platform, disable it.

4. Click Save.

One hour after activation of the Delivery Platform Integrations option, the store will be
visible and ready for ordering on the delivery service provider website.

Verifying Setup
After configuring Simphony, go to the delivery service website and verify the following
information:

1. The latest menu is synced to the website.

2. Place an order, and then confirm the check is printed in the kitchen.
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7
Accessibility

This chapter describes the accessibility feature in the EMC and its configuration. Accessibility
features aim to make using the product easier for persons with disabilities. Simphony currently
supports the high-contrast settings that are provided by the Microsoft Windows operating
systems.

Enabling High Contrast Visibility Settings
Enable High Contrast visibility settings based on the operating system that you are running on
your computer.

1. To enable high contrast visibility settings with Microsoft Windows 8.x or Microsoft Windows
10:

a. Click the Start button from your computer’s Desktop.

b. Type high contrast settings in the Search box, and then select High Contrast from
the list.

c. Select a high contrast theme from the Choose a Theme drop-down list.

d. Click Apply.

2. To enable high contrast visibility settings with Microsoft Windows 7:

a. Click the Start button from your computer’s Desktop, and then select the Control
Panel.

b. Click Appearance and Personalization, and then click Personalization.

c. Click the high-contrast theme that you want to use under Basic and High Contrast
Themes.

Navigating the Home Page Using Keystrokes
1. To place focus on the Location panel on the left, press Ctrl+H.

2. To expand a level (Enterprise or property) to show the locations beneath, press the right
arrow key.

3. To move between the locations in the hierarchy, press the up arrow key and the down
arrow key.

4. To open a module:

a. Press Ctrl+T to move focus to the tabs on the right, and then press the up arrow key
and the down arrow key to move between the tabs.

b. Press Tab to navigate to the first focusable element in the tab.

c. Continue to press Tab to navigate through the modules in the tab.

d. Press Enter to open the module.
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Keyboard Shortcuts
EMC supports standard keyboard shortcuts that are used in Microsoft Windows operating
systems. Additionally, EMC offers shortcuts to perform tasks that are specific to the application.
The following table describes keyboard shortcuts for use with EMC.

Table 7-1    General Keystrokes

Keyboard Shortcut Result

Tab Navigates to the next focusable field or element from top
to bottom and left to right.

Down Arrow Varies based on context:
• When moving through the location hierarchy in the

Home Page, moves one item downward through the
list.

• In a table, moves to the next row.
• When the focus is on a drop-down list, moves to the

next item in the list.

Up Arrow Varies based on context:
• When moving through the location hierarchy in the

Home Page, moves one item upwards through the
list.

• In a table, moves to the previous row.
• When the focus is on a drop-down list, moves to the

previous item in the list.

Right Arrow Varies based on context:
• In a table, navigates to the next column on the right.
• When moving through the location hierarchy in the

Home Page, expands the location to show the
properties or revenue centers beneath.

Left Arrow Varies based on context:
• In a table, navigates to the next column on the left.
• When moving through the location hierarchy in the

Home Page, collapses the list and sets the focus on
the parent location.

Delete Deletes the record selected.

Enter Triggers the activity, when the focus is on a link or a
button.

Insert Adds a new record.

Alt+E Accesses the Edit menu on the toolbar.

Alt+F Accesses the File menu on the toolbar.

Alt+H Access the Help menu on the toolbar.

Alt+V Accesses the (Table or Form) view menu (where
applicable) on the toolbar.

Ctrl+C In Table view, copies the record or records that are
selected.

Ctrl+F Opens the Find dialog which allows you to search for
records by entering a search criteria.

Crtl+G Opens the Go to Record dialog which allows you to go to a
record by entering the record's object number.
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Table 7-1    (Cont.) General Keystrokes

Keyboard Shortcut Result

Ctrl+H In the Home page, moves focus to the location hierarchy.

Ctrl+K Closes all open modules, including the Home Page, and
disconnects the user from the EMC.

Ctrl+O Opens the EMC Login page when disconnected from the
EMC.

Ctrl+P Print records while in Table view.

Ctrl+Q Closes the module that is active.

Ctrl+S Saves the changes.

Crtl+T Varies based on context:
• In the Home page, moves focus to the main tabs.
• In Table view, shows or hides the record filters.

Ctrl+V In Table view, pastes the copied records.

Shift+F10 In Table view, opens the right-click menu when the focus
is on a record.

F3/F4 In Table view, allows copy and paste of fields.
F3 copies the content in the cell and moves to the cell in
the next row. F4 pastes the contents and moves to cell in
the next row. This allows you to continually press F4 (or
hold it down) and paste the same information to multiple
cells in the same column.

F8 Opens the EMC Record Translation dialog.
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